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Notice Every effort was made to ensure that the information in this 
document was accurate at the time of printing. However, infor-
mation is subject to change without notice, and JDS Uniphase 
reserves the right to provide an addendum to this document 
with information not available at the time that this document 
was created.

Copyright © Copyright 2011 JDS Uniphase Corporation. All rights 
reserved. JDSU, Communications Test and Measurement 
Solutions, and its logo are trademarks of JDS Uniphase Cor-
poration (“JDS Uniphase”). All other trademarks and regis-
tered trademarks are the property of their respective owners. 
No part of this manual may be reproduced or transmitted elec-
tronically or otherwise without written permission of the pub-
lisher.

Copyright release Reproduction and distribution of this guide is authorized for 
Government purposes only.

Trademarks JDSU Uniphase, JDSU, MTS 5800 and T-BERD 5800 are 
trademarks or registered trademarks of JDS Uniphase in the 
United States and/or other countries.

Bluetooth is a registered trademark of The Bluetooth SIG, Inc. 
in the United States and/or other countries.

Specifications, terms, and conditions are subject to change 
without notice. All trademarks and registered trademarks are 
the property of their respective companies.

Ordering
information

The catalog number for a printed getting started manual is 
C5GSG. The catalog number for electronic manuals on USB 
memory stick is C5USB.

Terms and
conditions

Specifications, terms, and conditions are subject to change 
without notice. The provision of hardware, services, and/or 
software are subject to JDSU’s standard terms and condi-
tions, available at www.jdsu.com/terms.

http://www.JDSU.com/terms
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Federal
Communications

Commission (FCC)
Notice

This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential instal-
lation. This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interfer-
ence will not occur in a particular installation.

This device complies with Part 15 of the FCC Rules. Opera-
tion is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) This device must 
accept any interference received, including interference that 
may cause undesired operation.

If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:

– Reorient or relocate the receiving antenna.
– Increase the separation between the equipment and 

receiver.
– Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected.
– Consult the dealer or an experienced radio/TV technician 

for help.

In order to maintain compliance with the limits of a Class B 
digital device JDSU requires that quality interface cables be 
used when connecting to this equipment. Any changes or 
modifications not expressly approved by JDSU could void the 
user's authority to operate the equipment. 

Industry Canada
Requirements

This device complies with Industry Canada license-exempt 
RSS standard(s). Operation is subject to the following two 
conditions: (1) this device may not cause interference, and (2) 
this device must accept any interference, including interfer-
ence that may cause undesired operation of the device.
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Le présent appareil est conforme aux CNR d'Industrie Can-
ada applicables aux appareils radio exempts de licence. 
L'exploitation est autorisée aux deux conditions suivantes : (1) 
l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur 
de l'appareil doit accepter tout brouillage radioélectrique subi, 
même si le brouillage est susceptible d'en compromettre le 
fonctionnement.

This Class A digital apparatus complies with Canadian ICES-
003.

Cet appareil numérique de la classe A est conforme à la 
norme NMB-003 du Canada.

WEEE and Battery
Directive

Compliance

JDSU has established processes in compliance with the 
Waste Electrical and Electronic Equipment (WEEE) Directive, 
2002/96/EC, and the Battery Directive, 2006/66/EC.

This product, and the batteries used to power the product, 
should not be disposed of as unsorted municipal waste and 
should be collected separately and disposed of according to 
your national regulations. In the European Union, all equip-
ment and batteries purchased from JDSU after 2005-08-13 
can be returned for disposal at the end of its useful life. JDSU 
will ensure that all waste equipment and batteries returned are 
reused, recycled, or disposed of in an environmentally friendly 
manner, and in compliance with all applicable national and 
international waste legislation.

It is the responsibility of the equipment owner to return equip-
ment and batteries to JDSU for appropriate disposal. If the 
equipment or battery was imported by a reseller whose name 
or logo is marked on the equipment or battery, then the owner 
should return the equipment or battery directly to the reseller.

Instructions for returning waste equipment and batteries to 
JDSU can be found in the Environmental section of JDSU’s 
web site at www.jdsu.com. If you have questions concerning 
disposal of your equipment or batteries, contact JDSU’s 
WEEE Program Management team at 
WEEE.EMEA@jdsu.com.

http://www.JDSU.com
mailto:WEEE.EMEA@jdsu.com 
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About this Manual

This preface explains how to use this Getting Started manual. 
Topics discussed in this chapter include the following:

– “Purpose and scope” on page xiv
– “Assumptions” on page xiv
– “Terminology” on page xiv
– “Getting Started Manual” on page xvi
– “Conventions” on page xvii
– “Safety and compliance information” on page xix
– “Technical assistance” on page xx
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Purpose and scope
The purpose of this manual is to help you successfully use the 
features and capabilities of each of the members of the T-
BERD ⁄ MTS 5800 Handheld Network Test Family.

This manual includes task-based instructions that describe 
how to configure, use, and troubleshoot the general functions 
of the Handheld Network Test Family. Additionally, this 
manual provides a complete description of JDSU’s warranty, 
services, and repair information. For terms and conditions of 
the licensing agreement, go to go to www.jdsu.com.

Assumptions
This manual is intended for novice, intermediate, and experi-
enced users who want to use the Handheld Network Test 
Family effectively and efficiently. We are assuming that you 
have basic computer experience and are familiar with basic 
telecommunication concepts, terminology, and safety.

Terminology
The T-BERD 5800 is branded as the MTS-5800 in Europe, 
and it is interchangeably referred to as the T-BERD 5800, 
MTS 5800, MTS-5800, MTS5800 and Media Test Set 5800 
throughout supporting documentation.

The following terms have a specific meaning when they are 
used in this manual:

– OC-n — Used to refer to each of the optical SONET rates 
supported by the T-BERD ⁄ MTS 5800 (OC-3, OC-12, 
OC-48, and OC-192), where “n” represents the 
user-selected line rate.

http://www.jdsu.com
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– STM-n — Used to refer to each of the optical SDH rates 
supported by the T-BERD ⁄ MTS 5800M (STM-1, STM-4, 
STM-16, and STM-64), where “n” represents the 
user-selected line rate.

– STS-1 — Used to refer to the electrical equivalent of 
OC-1 (51.84 Mbps) supported by the T-BERD ⁄ MTS 
5800.

– STM-1e — Used to refer to the electrical equivalent of 
STM-1 (155.52 Mbps) supported by the T-BERD ⁄ MTS 
5800.

– 10/100/1000 Ethernet — Used to represent 10/100/
1000 Mbps Ethernet. The connector panel also uses 10/
100/1000 to identify the connector used for 10/100/
1000 Mbps Ethernet testing.

– 1GigE — Used to represent 1 Gigabit Ethernet. 
– 10GigE — Used to represent 10 Gigabit Ethernet.
– JDSU Ethernet test set — A test set marketed by JDSU 

and designed to transmit an Acterna Test Packet (ATP) 
payload. These packets carry a time stamp used to calcu-
late a variety of test results. The T-BERD ⁄ MTS 5800, 
FST-2802 TestPad, the SmartClass Ethernet tester, the 
HST with an Ethernet SIM, the T-BERD/MTS 8000 Trans-
port Module, and the T-BERD/MTS 6000A MSAM can all 
be configured to transmit and analyze ATP payloads, and 
can be used in end-to-end and loopback configurations 
during testing.
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– SFP — Small form-factor pluggable module. Used on the 
connector panel and throughout this manual to represent 
pluggable optical modules.

– XFP — 10 Gigabit small form-factor pluggable optical 
transceiver. A variety of optional XFPs are available for 
testing 10 Gigabit fibre circuits.

Getting Started Manual
This is the getting started manual for the T-BERD ⁄ MTS 5800 
Handheld Network Test Family. It provides basic instructions 
for setting up the T-BERD ⁄ MTS 5800, instrument specifica-
tions, and contact information for JDSU’s Technical Assis-
tance Center (TAC). Read this manual carefully before 
connecting your instrument to the circuit you are testing.

Figure 1  SFP transceiver

Figure 2 XFP transceiver
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Use this manual in conjunction with the following manuals:

– The Ethernet, IP and TCP/UDP, Testing Manual provides 
detailed instructions for testing on each of the listed 
networks. It also explains how to run key scripts and 
describes each of the available test results.

– The PDH, SONET, SDH and Next Gen Testing Manual 
provides detailed instructions for testing on each of the 
listed networks.

– Help. The topics addressed in the testing manuals are 
also available on the T-BERD ⁄ MTS 5800 in an HTML 
format.

Conventions
This manual uses conventions and symbols, as described in 
the following tables.

Table 1 Typographical conventions

Description Example

User interface actions and buttons or 
switches you have to press appear in 
this typeface.

Press the OK key.

Code and output messages appear in 
this typeface.

All results okay

Text you must type exactly as shown 
appears in this typeface.

Type: a:\set.exe in the dialog box.

Variables appear in this typeface. Type the new hostname.

Book references appear in this typeface. Refer to Newton’s Telecom Dictionary



About this Manual
Conventions

xviii T-BERD/MTS 5800 Getting Started Manual

Table 3 Symbol conventions

Table 2 Keyboard and menu conventions

Description Example

A plus sign + indicates simultaneous 
keystrokes.

Press Ctrl+s

A comma indicates consecutive key 
strokes.

Press Alt+f,s

A slanted bracket indicates choosing a 
submenu from menu.

On the menu bar, click 
Start > Program Files.

This symbol represents a general hazard.

This symbol represents hazardous voltages.

This symbol represents a risk of explosion.

This symbol represents a Note indicating related information or 
tip.

This symbol, located on the equipment, battery, or its pack-
aging indicates that the equipment or battery must not be 
disposed of in a land-fill site or as municipal waste, and 
should be disposed of according to your national regula-
tions.
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Table 4 Safety definitions

Safety and compliance information
Safety and compliance information for the instrument are 
provided in printed form and ship with your instrument.

WARNING
Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.
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Technical assistance
Table 5 lists contact information for technical assistance. For 
the latest TAC information, go to www.jdsu.com or contact 
your local sales office for assistance. Contact information for 
regional sales headquarters is listed on the back cover of this 
manual.

During off-hours, you can request assistance by doing one of 
the following: leave a voice mail message at the Technical 
Assistance number, e-mail the North American Technical 
Assistance Center, tac@jdsu.com, or submit your question 
using our online Technical Assistance Request form at 
www.jdsu.com.

Table 5 Technical assistance centers

Region Phone Number

Americas 1-866-ACTERNA 
(option #2)

301-353-1550

(1-866-228-3762, option #2)
tac@jdsu.com

Europe, Africa, and 
Mid-East

+49 (0) 7121 86 1345 
(JDSU Germany)

hotline.europe@jdsu.com

Asia and the Pacific +852 2892 0990 
(Hong Kong)

+86 10 6655 5988
(Beijing-China)

mailto:tac@jdsu.com
mailto:hotline.germany@jdsu.com
http://www.jdsu.com
mailto:tac@jdsu.com
http://www.jdsu.com
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Chapter 1 Introduction

This chapter provides a general description of the 
T-BERD ⁄ MTS 5800. Topics discussed in this chapter include 
the following:

– “About the T-BERD ⁄ MTS 5800” on page 2
– “Features and capabilities” on page 3
– “Configurations” on page 4
– “What ships with your instrument?” on page 6
– “Unpacking the components” on page 6
– “Inspecting the components for damage” on page 7
– “Inserting an SFP or XFP transceiver” on page 7
– “Removing an SFP or XFP transceiver” on page 10
– “JDSU recommended SFPs and XFPs” on page 11
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About the T-BERD ⁄ MTS 5800
The T-BERD ⁄ MTS 5800 family of testers is designed to be a 
rugged, portable, battery-operated test solution that facilitates 
the quick turn-up and troubleshooting of multiple services and 
network elements in the Metro and Core network. This allows 
providers who are expanding their offerings into new data and 
wavelength services to deploy a single technician to install 
and maintain new elements and services using one integrated 
instrument.

It is an all-in-one test solution for the following networks:

– T-Carrier (DS1 and DS3)
– PDH (E1 through E4)
– SONET (STS-1 through OC-192)
– SDH (STM-1e through STM-64)
– Ethernet (10/100/1000, 100 M Optical, 1 Gigabit Optical, 

10 Gigabit Ethernet LAN and WAN)
– IP (10/100/1000, 100 M Optical, 1 Gigabit Optical, 

10 Gigabit Ethernet LAN and WAN)
– TCP/UDP (10/100/1000, 100 M Optical, 1 Gigabit Optical, 

and10 Gigabit Ethernet LAN)

Figure 1 T-BERD ⁄ MTS 5800



Chapter 1 Introduction
Features and capabilities

T-BERD/MTS 5800 Getting Started Manual 3

Features and capabilities
Features and capabilities of the T-BERD ⁄ MTS 5800 include 
the following (assuming your instrument is optioned and 
configured to support the features):

– Electrical interface support — Ability to test circuits from a 
variety of electrical interfaces (DS1, E1 BNC, E1 RJ-48, 
E3, DS3, STS-1, E4, and STM-1e).

– SONET/SDH interface support — Ability to test circuits 
from a variety of SONET and SDH interfaces (OC-3/
STM-1 through OC-192/STM-64 interfaces).

– Ethernet interface support — Ability to test circuits from a 
variety of Ethernet interfaces (10/100/1000 Mbps Elec-
trical through 100M and1 GigE optical circuits), and 
10 GigE LAN and WAN optical circuits at 850 nm, 
1310 nm, and 1550 nm.

– Intuitive user interface — User interface facilitates quick 
test configuration and execution, and easy interpretation 
of test results.

– Detailed test results — You can use the entire screen to 
observe test results, or you can collapse and expand 
certain test results for which a variety of measurements 
are made (such as current, average, minimum, or peak 
throughput measurements). You can also suppress 
graphical result collection if you intend to run resource 
intensive applications. For Dual Term or Dual Through 
applications, you can observe test results for both ports 
simultaneously.

– Automatic traffic transmission —You can optionally set up 
Ethernet, IP, and TCP/UDP test applications to generate 
and transmit traffic automatically whenever you turn the 
laser on (for optical applications).

– VT-100 terminal emulation — If your instrument is 
optioned to do so, you can use it to emulate a VT-100 
terminal, and then connect it to a network element via a 
serial interface to gather information about the element.
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– Optical power measurements — Ability to measure optical 
power.

– Automated RFC 2544 — In addition to the standard tests, 
expert tests are now available which allow you to specify 
and review test settings quickly and efficiently.

– HTML viewer — An HTML viewer is available which 
allows you to easily view and navigate through HTML files 
on your instrument.

– Cable testing — Ability to examine the state of the cables 
used to transmit 10/100/1000 electrical Ethernet signals 
before you begin testing.

– Ethernet and Internet Protocol service verification — 
Ability to verify proper installation and maintenance of 
carrier-grade Ethernet and Internet Protocol services.

– TCP/UDP, FTP, and HTTP protocol support — The ability 
to transmit and analyze traffic carried using the TCP/UDP, 
FTP, and HTTP protocols. 

– VLAN, Q-in-Q, VPLS, and MPLS encapsulation support 
— The ability to transmit and analyze VLAN, Q-in-Q, 
VPLS, and MPLS encapsulated Ethernet traffic.

For a comprehensive list of features and capabilities for each 
technology supported, refer to the Testing Manual that 
shipped with your instrument.

Configurations
The T-BERD ⁄ MTS 5800 Handheld Network Test Family is 
factory-configured to meet your testing requirements. When 
you place an order for a T-BERD ⁄ MTS 5800, a customer 
service or sales representative will help you determine the 
right configuration for your needs.
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Table 1 describes the available configurations.

To discuss a specific configuration or to order accessories for 
your T-BERD ⁄ MTS 5800, contact JDSU Customer Care or 
your regional sales office. Contact information for regional 
sales headquarters is provided on the back cover of this 
manual. You can also contact JDSU through the company 
web site, www.jdsu.com.

Table 1 T-BERD ⁄ MTS 5800 configurations

Catalog Number Configuration

TB/MTS-5801 T-BERD ⁄ MTS 5800 Single Port Test set

TB/MTS-5802 T-BERD ⁄ MTS 5800Dual Port Test set

TB/MTS-5812 T-BERD ⁄ MTS 5800 10G and Dual Port Test set

TB/MTS-5801P T-BERD ⁄ MTS 5800 Single Port Test set with PDH

TB/MTS-5802P T-BERD ⁄ MTS 5800 Dual Port Test set with PDH.

TB/MTS-5812P T-BERD ⁄ MTS 5800 10G and Dual Port Test set with PDH

NOTE:
Some configurations also require you to purchase and install cer-
tain testing options; others require specific hardware connectors to 
connect to circuits for testing. For example, if your instrument does 
not have a connector designed to support 1GigE Optical testing, 
you can not transmit and analyze a signal or traffic over a 1GigE 
circuit.

You can quickly determine whether or not your instrument sup-
ports certain applications by exploring the technologies, rates, and 
test modes presented on the Test menu and by reviewing the set-
tings available when you configure a test.

http://jdsu.com
http://jdsu.com
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What ships with your instrument?
The following items typically ship with the 
T-BERD ⁄ MTS 5800:

– T-BERD ⁄ MTS 5800 unit
– SFPs/XFPs — When you place your order, a customer 

service representative will let you know which trans-
ceivers are available from JDSU. Additional transceivers 
can be ordered separately for an additional charge.

– Power adapter — A power adapter designed specifically 
for use with the T-BERD ⁄ MTS 5800 is included. Use only 
the JDSU Power Adapter that shipped with the unit. For 
details, refer to “Powering the instrument” on page 14.

– RJ45 patch cable
– SMA to BNC adapter barrel adaptor — If you order an 

instrument with SONET testing capabilities, an adapter is 
supplied to convert the external clock input connector to a 
BNC connector.

– Carrying case — A carrying case is included with the 
T-BERD ⁄ MTS 5800. Always use this carrying case when 
transporting your instrument, and follow the instructions 
provided with the carrying case carefully.

– User documentation — A Getting Started Manual and 
Testing Manuals (on USB), a list of JDSU recommended 
optics (SFP and XFP transceivers), and a comprehensive 
help system also ship with the instrument. Remote control 
command documentation is also available on the docu-
mentation USB.

Unpacking the components
JDSU typically ships the Handheld Network Test Family using 
anti-static packing material to stabilize the components inside 
the box.
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When unpacking the components, verify that all the items you 
ordered are included in the package. Accessories may be 
shipped in a separate box.

After you unpack the components, you should inspect them 
for damage.

If undamaged, consider saving the box and packing materials 
in case you need to repackage the components for shipment. 
For information about shipping equipment, see Appendix B  
“Storage and Shipment” .

Inspecting the components for damage
After you unpack the components, examine the connectors, 
ports, LEDs, and screen for damage. Be sure to check the top, 
bottom, and front panels.

If you find damage, contact JDSU Customer Care at 
1-866-228-3762 or at www.jdsu.com. For information about 
returning equipment, see “Returning equipment to JDSU” on 
page 127.

Inserting an SFP or XFP transceiver
The SFP ports allow you to insert SFP transceivers designed 
for testing a variety of optical circuits. Additionally, the 
T-BERD/MTS 5812 and 5812P configurations also offer an 
XFP port, which allows you to insert a XFP transceiver to 
establish connections to 10Gig circuits.

Before inserting an SFP or XFP, consider the following:

– Applied power must not exceed the power level specified 
on the panel for each optical connector.

http://www.jdsu.com 
http://www.jdsu.com
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– Use the SFPs that shipped with your unit, or SFPs on the 
list of JDSU supported optics (transceivers) that shipped 
with your instrument. The recommended optics are also 
available on your unit by selecting 
Help > Recommended Optics. These SFPs can be 
purchased from JDSU.

– Verify that the transceiver and the connector support the 
same physical interfaces. For example, if you intend to 
connect to a 10 Gigabit Ethernet circuit, verify that you are 
inserting an XFP into an XFP port.

– Details concerning the SFP or XFP used for the currently 
selected application are available on the Interface setup 
tab.

To insert an SFP or XFP transceiver

1 Obtain an SFP or XFP transceiver from JDSU that 
supports the physical interface you intend to test.
If you are not certain which interfaces a particular trans-
ceiver supports, refer to the list of JDSU Recommended 
Optics. 
If you can not locate the sheet, in most instances an 
online search using the model number (printed on the 
SFP or XFP label) will result in a number of hits providing 
specifications for the transceiver.

2 After verifying that you have the correct SFP or XFP for 
the interface, do the following:

a Position the instrument with the connector panel facing 
towards you.
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b Ensure that the bale-clasp latch on the SFP is closed 
as illustrated in Figure 2. The bale-clasp latch handle 
should be on top of the SFP module.

c With the SFP label facing away from you, align the 
SFP with the connector cage, and then gently but 
firmly insert the SFP until it is seated securely, indi-
cated by an audible click, or by feeling the SFP snap 
into place. 

CAUTION: DAMAGE TO UNIT: 
If you feel any resistance when first inserting the SFP 
into the cage, do not force it any further. The bottom of 
the SFP may be obstructed by the latch tab in the cage, 
and forcing it any further may damage the cage.
If this occurs, do the following:
Remove the SFP, then push the latch tab in the cage 
down.
Verify that the bale-clasp latch on the SFP is 
completely closed, re-align the SFP with the cage, and 
then insert it again. 

Figure 2 SFP transceiver with closed bail-clasp 
latch

NOTE:
The user interface may show the SFP as available before it 
is seated securely. Be sure to insert the SFP until you hear 
the click or feel it snap into place.
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The transceiver is inserted. Be certain to replace the rubber 
cover on the SFP or XFP when it is not in use.

Removing an SFP or XFP transceiver
To prolong the life of your transceivers, leave the SFPs or 
XFPs you intend to use most frequently in the instrument until 
you need to replace them with transceivers designed for a 
different circuit.

To remove an SFP or XFP transceiver

1 If necessary, remove the dust cover, or any cables that 
are currently connected to the transceiver. If you need to 
remove a cable, do the following:

a Press the release latch on the cable.

b Grasp the cable connector near the connection point.

NOTE:
Although it is possible to insert an RJ-45 SFP into a SFP 
port on the T-BERD ⁄ MTS 5800, the instrument will issue 
an error message if this is done. Insert optical SFPs into 
the SFP ports. Use the fixed RJ-45 test ports for 10/100/
1000 testing.

NOTE: Laser warm up requirement
When testing 10 Gigabit optical circuits using an XFP, some 
lasers (particularly 1550 nm lasers) are temperature stabi-
lized; therefore, the XFP need to reach a certain tempera-
ture before you can use them to transmit a signal. This is 
expected behavior, and does not indicate that there is 
something wrong with the laser or test instrument.

It typically takes up to one minute for the temperature to 
stabilize. If you have turned the laser on, but no signal is 
present on the receiving instrument or device, simply wait 
for one minute.
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c Gently pull the cable connector from the transceiver.

d Insert a dust plug into the open end of the transceiver.

2 Open the bail-clasp latch (as illustrated in Figure 3), and 
grasp the latch and pull gently upwards to remove the 
transceiver from the cage.

The transceiver is removed. Be certain to store it in an anti-
static bag.

JDSU recommended SFPs and XFPs
To ensure proper operation of your instrument during testing, 
we strongly recommend purchasing the required transceivers 
from JDSU. These transceivers have been tested to verify that 
they will perform reliably with our test instruments.

A list of recommended transceivers can be found by select-
ing Recommended Optics from the Help menu. Or you can 
obtain the list by contacting JDSU Customer Care, or con-
tacting JDSU via the company web site, www.jdsu.com.

Figure 3 SFP transceiver with open bail-clasp latch

http://www.jdsu.com
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Chapter 2Getting Started

This chapter explains how to start using your 
T-BERD ⁄ MTS 5800, and describes the user interface. Topics 
discussed in this chapter include the following:

– “Powering the instrument” on page 14
– “Exploring theT-BERD ⁄ MTS 5800” on page 15
– “Navigating the user interface” on page 18
– “Setting up the instrument” on page 26
– “Preparing for optical testing” on page 33
– “Connecting the T-BERD ⁄ MTS 5800 to the circuit” on 

page 36
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Powering the instrument
Power is supplied to the instrument by the battery or the AC 
power adapter supplied with the instrument when it was 
shipped to you. 

Verifying that
you have the

correct adapter

Figure 4 shows the label provided on the adapter that ships 
with the T-BERD ⁄ MTS 5800.

Using the
adapter

To supply power using the adapter

1 Verify that the adapter is the one that shipped with your 
instrument (see “Verifying that you have the correct 
adapter”).

2 Plug the adapter into the power supply jack on the top 
panel.

3 Plug the opposite end of the adapter into the power 
mains.

Power is supplied using the adapter.

For specifications, see “Power specifications” on page 104. 

Figure 4 Adapter label
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Turning on the
instrument

To power the instrument
– Press the ON/OFF key.

The instrument powers up and power key illuminates green. 

Turning off the
instrument

To turn off the instrument
– Press the ON/OFF key for one second. After the confir-

mation message appears, select Yes to power down.

The instrument saves the current settings and then shuts 
down. The next power up will return to the last test running.

Charging the
battery

In most instances, the battery charges automatically when 
you supply power to the unit using the AC power adapter. 

Exploring the T-BERD ⁄ MTS 5800
The connector panel of the T-BERD ⁄ MTS 5800 provides the 
internal connectors and SFP connectors used to connect the 
instrument to the circuit for testing. After selecting a test appli-
cation, LEDs illuminate indicating which connectors to use for 
your test.

A variety of hardware configurations are available for the 
T-BERD ⁄ MTS 5800; therefore, your unit may not have all of 
the connectors in Figure 5 on page 16. This figure illustrates 
the configuration T-BERD/MTS 5812P - 10G and Dual Port 
Test set with PDH. Refer to Appendix A  “Specifications” for 
detailed connector specifications.

NOTE:
Pressing the power button for more than four seconds 
causes a hard shut-down. The current settings are not 
saved and the next power up it will launch the first test 
available.
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SFP and XFP
connectors

One XFP and two SFP connectors allow you to connect the 
T-BERD ⁄ MTS 5800 to a SONET, SDH, 1 Gigabit Ethernet, 
10GigE, 100 FX, or 100M Ethernet circuit to transmit and then 
analyze traffic.

E3/DS3/STS-1/
E4/STM1(e)
connectors

One Tx/Rx pair or two receivers allow you to connect the 
T-BERD ⁄ MTS 5800 to an E3, DS3, STS-1, E4, or STM-1e 
circuit to transmit and analyze traffic.

10/100/1000M
connectors

Up to two 10/100/1000M connectors allow you to connect the 
T-BERD ⁄ MTS 5800 to an electrical Ethernet circuit to 
transmit and analyze traffic.

E1 connectors Two unbalanced 75 Ω BNC receivers, and one unbalanced 
75 Ω BNC transmitter allow you to connect the instrument to 
an E1 (2M) circuit to transmit and analyze traffic. The 
Rx 2 receiver can be used as the input for a SETS signal or 
an E1 reference clock. 

Figure 5 Connector panel, top of T-BERD/MTS 5812P
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E1 RJ 48
transmitter/

receiver

One balanced 120 Ω RJ 48 transmitter/receiver allows you to 
connect the T-BERD ⁄ MTS 5800 to an E1 (2M) circuit to 
transmit and analyze traffic.

DS1 connectors Two DS1 Bantam receivers and one DS1 Bantam transmitter 
allow you to connect the T-BERD ⁄ MTS 5800 to a DS1 circuit 
to transmit and analyze traffic. The Rx 2 receiver can be used 
as the input for a DS1 BITS signal.

EXT CLK
connector

SMA connector for external clock input. Use the SMA to BNC 
barrel adaptor if a BNC connector is needed.

Headset/
handset

connector

Use the headset connector when dropping voice traffic from a 
DS0 interface.

USB host
connector

Located on the right side of the unit, the two USB host connec-
tors (USB 2.0) allow connection of a USB drive, or other USB 
device.

LAN connector Located on the right side of the unit, the RJ-45 LAN connector 
is used to connect to your local network.

RS-232
connector

Located on the right side of the unit, the RJ-45 RS-232 
connector is used to connect to network elements when using 
the optional VT-100 emulation feature.

NOTE:
The E1 and DS1 interfaces should not be connected at the 
same time. After running your test, disconnect from one 
interface before connecting to the other interface.
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Navigating the user interface
The user interface lets you set up the instrument, configure 
tests, and display test results. See Figure 6.

System and
Test icons

Use the System icon to access the system settings (such as 
setting the date and time, and managing files).

Use the Test icon to access the test applications.

File viewer icon Appears when a file is open, such as a report or the help 
manual. Clicking on the icon shows the file viewer.

Figure 6 Main screen (Ethernet application)
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Menu Bar The menu bar provides the following menus:

Test

Use the options listed on the Test menu to select your test 
application.

For example, to transmit patterns in a STS-48c Bulk BERT 
payload over an OC-48 circuit, select:

Test> SONET> OC-48 > STS-48c Bulk BERT > 
Terminate

View

Use the options listed on the View menu to change the format 
of the Main screen. Options are provided which allow you to 
change the result layout and hide or display a variety of items 
on the Main screen, such as the Message bar, LED panel, 
Signal Structure (graphical display), and the Actions panel. An 
option is also available which allows you to toggle between 
tests running on different ports.

Reports

Use the options on the Reports menu to create, view, and 
export custom reports for your instrument. You can also 
enable and configure automatic reports using the Automatic 
Reports option.

Tools

Use the options on the Tools menu to import or export a 
variety of files from the unit, such as test configurations or 
screenshots and to activate new test options on your instru-
ment. The Clear History option clears all historical LEDs.

Help

Use the Help menu to launch a help system with each of the 
topics discussed in the testing manual, or to view a variety of 
useful reference diagrams, such as signal connections.
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Test tab The current test tab appears near the menu bar of the Main 
screen (as shown in Figure 7). When multiple tests are 
running, two tabs appear. Clicking on the tab takes you to that 
test. For more information on multiple tests, see “Running 
multiple tests” on page 61. 

VNC icon Indicates that someone has a remote connection to the unit 
using VNC.

Test status The test status of the currently selected test is displayed in the 
upper right. Icons similar to a DVD or audio player indicate the 
status: the “Play” icon indicates a test is running; “Pause” 
appears when running a delayed-start timed test and the test 
has not started yet, and “Stop” appears when the test is 
stopped.

Incoming power
level

Indicates the power level of the incoming signal.

Application
buttons

The buttons located on the right side of the screen allow 
access to the setup screens, restart tests, and perform other 
functions specific to your test application.

Figure 7 Test tab

Figure 8  Test running and elapsed time
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Setup/Results

The top button (Setup/Results) is used to toggle between the 
Setup screens and the Main (Result) screen. When the Main 
screen is displayed, the Setup button appears; when the 
setup screens are displayed, the Results button appears.

A Restart button is also provided which allows you to restart 
a test (and clear results). 

A Start Test/Stop Test button is provided to begin or end a 
test.

Additional buttons appear when appropriate for the test appli-
cation you select. For example, if you select a 
Layer 4 Multiple Streams Ethernet application, a Toolkit 
button is provided which provides a number of tools to simplify 
testing.

For descriptions of setup parameters, refer to the testing 
manual.

Message Bar The message bar displays the current test application 
selected on the unit. For example, if you selected the Layer 4 
Multiple Streams application for a 10GigE LAN circuit, the 
following application appears in the message bar:

10GigE LAN Layer 4 Streams Term

If your instrument is configured with two ports for a particular 
rate, the currently selected port also appears at the beginning 
of the message.
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Various other messages may appear briefly, for example, to 
alert you that loop ups are successful. You can display a log 
of messages by clicking anywhere on the message bar.

Quick Config
settings

After you select a test application (using the Test menu), a 
Quick Config tab appears under the Message Bar, with key 
settings required to configure your test. For example, if you 
selected the SONET -> OC-192 -> OC-192c Bulk BERT - > 
Terminate application, quick configuration settings appear 
that allow you to automatically detect and insert a BERT 
pattern. See Figure 9.

Signal
Structure

If you are running a SONET, PDH, or SDH application, a 
Signal Structure tab appears to the right of the Quick Config 
tab. When selected, the Tx side shows the structure of the 
signal sent out by the test set, and the Rx side shows the 
structure of the signal that the test set is configured to receive. 
Figure 10 illustrates the signal structure when you transmit a 
Bulk BERT payload in an STS-48c signal

LED Panel The LEDs in the panel to the left of the Results Windows help 
you determine whether a signal is present, pattern synchroni-
zation has been achieved, and other key events when 
performing tests.

Figure 9 Quick Config Settings

Figure 10 STS-48c Bulk BERT signal structure
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You can collapse and expand an LED panel by tapping the 
panel name (for example, SONET).

For descriptions of each of the LEDs, refer to the Test Results 
chapter in the testing manual that shipped with your instru-
ment.

Current and
history LEDs

The round LEDs on the inside column provide the current 
state of the key event; the square LEDs on the outside column 
provide the historical state (in other words, the event occurred 
in the past).

LED colors Green LEDs indicate an event occurred as expected, yellow 
LEDs indicate that an event occurred that warrants additional 
investigation, and red LEDs indicate that an error (anomaly) 
or alarm (defect) has occurred.

LEDs for muxed
payloads

When testing muxed payloads, panels appear for each of the 
payloads (in addition to the LEDs for the interface rate). For 
example, if you are testing an E1 BERT payload carried in a 
DS3 signal, a DS3 panel and a E1 panel appear.

10 Gigabit
Ethernet WAN

LEDs

When testing 10 Gigabit Ethernet WAN circuits, a SONET or 
SDH panel and an Ethernet panel appear.

Actions Panel After you select a test application (using the Test menu), an 
Actions Panel appears at the bottom of the screen that 
provides tabs with the buttons required to perform your test. 
The buttons available vary depending on the test application 
you select. For example, buttons may appear that allow you 
to start and stop transmitting Ethernet traffic, start and stop a 
local loopback, or, if you selected a SONET application, allow 
you to specify error (anomaly), alarm (defect), and pointer 
parameters for the test. 
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A blinking circle on a tab indicates that some action is required 
on your part. For example, if you are running a BERT test, the 
Actions tab may blink indicating that you need to start trans-
mitting the BERT pattern.

If you select a test application for an optical rate, a 
Laser  tab also appears, with buttons that allow you to specify 
the clock source and turn the laser on and off. See Figure 11.

If you do not see the Actions Panel, select View > Actions 
Panel on the Menu Bar, and then select the tab with the 
buttons that you need.

You can also hide the Action Panel on the Main screen by 
clearing the View > Actions Panel selection.

Result Buttons Group and Category buttons are provided at the top of each 
result window. The Group button on the left allows you to 
select the type of results you want to observe (for example, 
Summary results); the Category button on the right allows you 
to select a specific results category for the group you speci-

Figure 11 Laser buttons

NOTE:
The color of a button reflects its current state. Action buttons 
are highlighted in yellow when they are turned on; they are 
grey when they are off.
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fied. By selecting a different group or category for each pane, 
you can view multiple sets of results at the same time. See 
Figure 12.

Result
Windows

The test results appear in Result Windows (see Figure 13). 

Errors are highlighted in red; other results appear in black. 
The warning icon (exclamation point inside the triangle) indi-
cates that the result will appear in the “Summary Status” 
window. The color of the icon indicates the Summary window 
background color: a test error will cause a red background; a 
yellow result may indicate that the test is mis-configured 
(framing mismatch, ATP payload selected but no ATP packets 
received).

Figure 12 Result Buttons (SONET application)

Group Category

Figure 13 Result Window (Ethernet application)
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You can change the layout of the Result Windows using 
options provided on the View menu. You can also choose to 
show just test results on the main screen by selecting 
View > Show Only Results.

For test result descriptions, refer to the Test Results chapter 
in the Testing Guide for the interface you are testing.

Setting up the instrument
Setting up the instrument involves items such as specifying 
the language, setting the date and time, setting up the screen 
saver, and indicating whether you want your LEDs displayed 
using the format used on the FST-2000 TestPad format, or the 
format used on the ANT platform.

The System menu, shown in Figure 14, provides access to 
regional settings, the date and time, and adjusting display 
settings.

Figure 14 T-BERD ⁄ MTS 5800 System Menu
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Specifying
international

settings

Before testing, you can specify the language and the date and 
time format for the user interface.

To specify international settings

1 Select the SYSTEM icon.
The System screen appears.

2 Select Region.
The System Setup screen appears, listing settings that 
control the appearance and behavior of your unit.

3 In the Language box, select the language for the user 
interface.
The formatting standard changes automatically.
In the Samples for selected formatting box, the date, 
time, and number formatting appear. 

4 If you want to change the formatting standard, click the 
Change formatting standard box, and then select a 
country.

5 If you wish to do so, click the check box next to Use 24-
hour time.

6 Turn the instrument off then back on.
The user interface changes to the language you specified.

Setting the date
and time

The T-BERD ⁄ MTS 5800 has an internal clock that you can 
set to provide accurate time stamps for test results.

To set the date and time

1 Select the SYSTEM icon.

2 Select Date and Time.

3 Specify the Region, Country, and Area, and if you wish 
to do so, click the check box for Automatically adjust for 
daylight savings time.
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4 Under Current Date & Time, do the following:

a Use the up and down arrows to specify the current 
local time. If you wish to do so, click the check box 
next to Use 24-hour time.

b Use the calendar to select the current date.

Checking the
battery

You can check the status of the battery in two ways:

Method 1 — The battery status indicator in the upper right corner of 
the screen provides a graphic indication of the approximate battery 
charge.

Method 2 — The Battery Level percentage on the Battery status 
page. 

1 Select the SYSTEM icon.

2 Select Battery.
The battery status appears.

3 View the Battery Level.
The Battery Status page indicates the charge level (both 
in percentage under the battery and the color of the 
battery), whether the adapter is plugged in, and indicates 
the battery temperature range.

Battery Indicator
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Setting up the
display

Setting up the display includes setting the screen brightness 
and setting up the screen saver.

Adjusting screen
brightness

The following procedure describes how to adjust the screen 
brightness.

To adjust the screen brightness

1 Select the SYSTEM icon.

2 Select Display.

3 Change the brightness level by moving the slider left or 
right.

Setting up the
screen saver

If you are operating the instrument using the battery, you 
should set up the screen saver to switch off the screen auto-
matically after the unit has not been used for a specific interval 
of time. 

To set up the screen saver

1 Select the SYSTEM icon, and then select Display.

2 To enable the screen saver, click the check box next to 
Enable automatic screen saver.

3 To change the message displayed as a screen saver, 
click in the Message field, and then enter the message.

4 To specify the time to wait until the screen saver begins, 
do the following:

a Click on the drop down next to the Delay field, and 
then specify the time unit, for example, seconds, 
minutes or hours.

NOTE:
The Display menu also allows calibration of the touch-
screen. See “Calibrating the touchscreen” on page 93.
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b Click in the Delay field. A keyboard appears. Enter the 
amount of time, and then click OK. For example, if you 
selected minutes in the previous step, enter the 
number of minutes of delay.

5 Click the check box next to Screen saver password if 
you wish to enable a screen saver password (a password 
is required to close the screen saver and resume using 
the instrument). Make a note of the password and put it 
somewhere safe.

The screen saver is setup.

Customizing
the user

interface look
and feel

You can set up the T-BERD ⁄ MTS 5800 to emulate the FST-
2000 TestPad user interface (TestPad mode), or the ANT 
platform user interface (ANT mode). This primarily impacts 
the LED result format on the Main screen.

TestPad mode

If you specify TestPad mode for the LED display, the inside 
green LEDs illuminate sequentially as key events occur, such 
as signal detection, frame synchronization, and pattern 
synchronization. The Status LED illuminates green if all 
summary results are OK. If the test stops, the Status LED is 
locked until you start or restart the test.
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Figure 15 illustrates the LED panel for a SONET application in 
TestPad mode.

If the instrument loses any of the LED events, the green 
Status LED extinguishes, and the red Alarm LED in the history 
column illuminates indicating an error condition has occurred. 
For example, if the instrument detected a signal, but then 
loses it, the green Signal Present LED extinguishes, and the 
red LED in the history column illuminates. If the instrument 
then regains a signal, the green Signal Present LED illumi-
nates, and the red history LED stays illuminated until you clear 
history LEDs or restart the test.

ANT mode

If you specify ANT mode for the LED display, the LEDs illumi-
nate red when key events or errors occur. For example, if the 
instrument does not detect a signal, the associated LOS LED 
illuminates. When the instrument detects a signal, the LOS 
LED extinguishes.

Figure 15 SONET LED Panel in TestPad mode

Alarm LEDs

Status LED
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Figure 16 illustrates the LED panel for a SONET application in 
ANT mode.

To specify the LED results mode

1 Select the “Test” icon.
The Main screen appears.

2 Select Tools > Customize.
The Customize User Interface Look and Feel screen 
appears.

3 Select the Result/Setup Terminology field, and then select 
ANT or TestPad mode.

4 Select Close to store the result mode and return to the 
Main screen.

Figure 16 SONET LED Panel in ANT mode
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Preparing for optical testing
Before testing on optical circuits using the 
T-BERD ⁄ MTS 5800, you should be familiar with the following 
items.

Considerations Consider the following before testing on optical circuits:

– Only use the SFPs and XFPs that shipped with your 
instrument, or SFPs and XFPs purchased from JDSU as 
accessories. A list of JDSU supported optics (trans-
ceivers) shipped with your instrument and is also avail-
able on the Help menu under Recommended Optics.

– Details concerning the SFP used for the currently 
selected application are available on the Interface setup 
tab.

WARNING: HAZARDOUS LIGHT EXPOSURE
Do not look directly into the optical output of the unit or at 
the output of any optical cable or transceiver connected to 
the unit. If a fiber optic cable is removed from a transmitting 
connector or transceiver, cover the connector with the safety 
cap to prevent inadvertent exposure to the laser output. 

WARNING: RISK OF DAMAGE TO TRANSCEIVERS
When connecting the instrument to optical circuits using an 
SFP or XFP, do not apply optical power that exceeds the 
maximum optical power published as permitted by the trans-
ceiver manufacturer.

If you do not know the optical power of the applied signal, 
use an attenuator when you connect to the circuit for the 
first time, then remove the attenuator if you determine that it 
was not necessary. Otherwise, the transceiver can be per-
manently damaged due to the “hot signal”.

A variety of attenuators are available for purchase as 
options when you order your instrument.
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Tuning XFPs The ITU-T G.694.2 standard provides a frequency grid for 
DWDM which creates channel spacing from 12.5 GHz to 
100 GHz. The channel spacing allows different carriers to run 
on the same fiber. Using a tunable XFP in our instrument, you 
can use different channels or wavelengths. Most XFPs are 
designed for C-band wavelengths.

To tune a XFP

1 Verify whether your XFP supports tuning by viewing the 
Connector Setup.

This screen varies depending on the XFP device.
Notice the first two lines. The first line indicates that the 
XFP is tunable, and may show which wavelengths are 
tunable. The second line indicates which types of tuning 
are supported.

Figure 17 XFP connector properties
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2 To specify tuning, do the following:

a Press the Results application button to return to the 
Result screen

b Use the Laser action buttons to specify the Tuning 
Mode: Wavelength or Channel.

c If you selected Wavelength, click on the wavelength 
field, and use the keypad to enter the wavelength.
If you selected Channel, click on the channel field, and 
use the keypad to enter the channel.

Figure 18 Tuning the XFP

NOTE:
You can also specify the tuning mode and wavelength/
channel in the Setup menu on the Signal tab.
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Connecting the T-BERD ⁄ MTS 5800 to the circuit
When connecting the instrument to the circuit, these basic 
steps should be followed.

To connect the instrument to the circuit

1 If you are testing on an optical circuit, insert the appro-
priate SFP or XFP (see “Inserting an SFP or XFP trans-
ceiver” on page 7).

2 Select the cable for the circuit. When selecting the cable, 
consider the following:
– Are you testing an electrical or optical circuit?
– If you are testing an optical circuit, is it a single-mode 

or multi-mode circuit? Do you have the appropriate 
attenuator for the cable?

– What type of connectors are required? For example, if 
you are connecting to the circuit from a device with LC 
connectors, you can use an LC to LC cable.

3 Connect one end of the selected cable to the appropriate 
transceiver or jack on your instrument, and then connect 
the other end to the device on the circuit. If you are 
connecting to an optical circuit, be certain to attenuate the 
signal.

4 If you connected to an optical circuit, determine whether 
you can remove the attenuator by observing the 
Optical Rx Level (dBm) result in the Interface 
group, Signal category. If attenuation is not necessary, 
remove the attenuator, reconnect the cable to the trans-
ceiver, and then press Restart.

The T-BERD ⁄ MTS 5800 is connected to the circuit.



3

T-BERD/MTS 5800 Getting Started Manual 37

Chapter 3System Tools

This chapter describes the system tools on the instrument. 
Topics discussed in this chapter include the following:

– “System menu” on page 38
– “Managing files” on page 38
– “Viewing USB storage devices” on page 40
– “Pairing Bluetooth devices” on page 41
– “Specifying network settings” on page 41
– “Accessing the T-BERD ⁄ MTS 5800 remotely” on page 43
– “Locking the test set” on page 45
– “Restoring factory defaults” on page 46
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System menu
The System menu, shown in Figure 19, provides access to 
system tools such as the file manager, network settings, 
display settings, 

Managing files
The File Manager enables you to open, copy, cut, paste, 
delete, or rename files or folders on the internal filing system.

To manage files

1 Select the SYSTEM icon, and then select Files.
A list of folders appears.
If a USB stick is attached, you will see folders for the 
internal Disk and folders for the USB.

2 Click on the desired folder or file to view the available 
actions.

Figure 19 T-BERD ⁄ MTS 5800 System Menu
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3 To select multiple files, click on the Select dropdown box 
and click Multiple.

4 To copy file or folder/directory, do the following:

a Click on the desired folder or file.

b Click Copy.

c Navigate to the desired location (where you want to 
paste the file/folder).

d Click Paste, located above the file list.
This is only available if you have copied a file or folder.

5 To view files inside a folder, click a folder and then click 
Open. A list of files appears.

6 To open a file, click on the file, and then click Open.
The contents of the file appear.

7 To move a file or folder, do the following:

a Click on the desired folder or file.

b Click Cut.

c Navigate to the desired location (where you want to 
paste the file/folder).

d Click Paste, located above the file list.
This is only available if you have copied or cut a file or 
folder.

8 To delete a file or entire folder, click on the desired file or 
folder, and then click Delete. An acknowledgement 
screen appears. Click OK to delete.

NOTE:
Some file types are not supported on the instrument. For 
example, if you capture and save packets, the .pcap file 
cannot be viewed on the T-BERD ⁄ MTS 5800 unless you 
open Wireshark before viewing the file. Alternatively, the file 
could be exported to a PC for viewing in Wireshark.
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9 To rename a file or folder, do the following:

a Click on the desired file or folder.

b Click Rename.

c Click in the name field.
A keypad appears.

d Enter the name, and then click OK.
The new file or folder name appears in the list.

Viewing USB storage devices
The USB menu allows you to view any USB storage devices 
connected to the T-BERD ⁄ MTS 5800.

To view USB devices

1 Select the SYSTEM icon.

2 Select USB.
Any USB storage device connected to and recognized by 
the T-BERD ⁄ MTS 5800 is listed.

NOTE:
When USB storage is found, this menu display shows the 
amount of storage. Please note that 122 MB of storage 
actually indicates 128 MB of space. This is due to the math 
of dividing the available bytes by (1024 x 1024).
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Pairing Bluetooth devices
The Bluetooth® feature allows wireless transfer of files, within 
a range of 33 feet (10 meters). In order to transfer the file, the 
devices must be paired. Bluetooth pairing occurs when two 
Bluetooth devices agree to communicate with each other and 
establish a connection. 

To pair Bluetooth devices

1 Select the SYSTEM icon.

2 Select Bluetooth.

3 Check the box beside Enable Bluetooth.
If any devices have been previously paired, they will 
appear under Paired devices.

4 Select Discover Devices.
The instrument will scan for near-by Bluetooth devices.

5 To pair with a discoverable device, click on the device.

6 If another device is attempting to pair with you, click 
Receive connections to allow the pairing.

The device appears under “Paired devices”.

Specifying network settings
If you wish to access the instrument remotely, the network 
settings must be set to match the network it is connected to.

To specify network settings

1 Select the SYSTEM icon.

2 Select Network.

3 Specify whether the IP mode is Static or DHCP.
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4 If you specified Static IP mode, do the following.

a Select IP address, then enter the IP address.

b Select Net Mask, then enter the net mask address.

c Select Gateway, then enter the gateway address.

d Select DNS, then enter the address of the DNS server.

5 Select Enable wireless adapter.
In order to access wireless networks, you must have the 
JDSU USB Wifi Dongle plugged into the instrument. The 
order number for this is 21139796.
The T-BERD ⁄ MTS 5800 searches for nearby networks.
Table 2 explains each of the icons that may appear to the 
right of the network name.

6 Select a network to connect to.

7 If you selected a secure network, the keyboard appears. 
Enter the key code, and then click OK.

The network settings are specified.

Table 2 WiFi icons

Icon Indicates

Secure network. Access requires entry of a WEP/
WPA key. 

An encrypted network that the T-BERD ⁄ MTS 5800 
doesn’t support.
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Accessing the T-BERD ⁄ MTS 5800 remotely
The Remote Access features allows you to access the 
T-BERD ⁄ MTS 5800 user interface from a PC or laptop 
computer through a virtual network connection (VNC), 
connecting over an Ethernet interface.

To use this feature, you must have either a browser that 
supports VNC, or must have a third-party VNC viewer. In addi-
tion, the T-BERD ⁄ MTS 5800 must be connected to the same 
network as the PC or laptop, and you must know the IP 
address of the T-BERD ⁄ MTS 5800.

To access the T-BERD ⁄ MTS 5800 remotely

1 Using an Ethernet cable, connect the 
T-BERD ⁄ MTS 5800 to same Ethernet LAN as the PC or 
laptop you will use for the VNC.

2 Turn the Remote Operation feature On by doing the 
following:

a Select the SYSTEM icon, and then select Remote.

b Check the box next to Enable VNC access.

3 If you wish to limit the number of connections to the instru-
ment, do the following:

a Click the box for Password protect.
When checked, the instrument will prompt for a pass-
word before allowing VNC access.

b If you wish to change the password, click in the pass-
word field, and using the on-screen keypad, enter the 
password, and then click OK.

4 Configure the Network settings to match your LAN 
settings (see “Specifying network settings” on page 41). 

5 Establish the VNC connection.
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a Do one of the following:
– If you are using a browser that supports VNC, point 

the browser to the IP address of the unit by typing into 
the address bar, including the VNC port number 
(5800). For example, http://192.168.0.1:5800.

– If you have a third-party VNC viewer, launch VNC 
viewer, and then enter the T-BERD ⁄ MTS 5800’s IP 
address, and then select OK.

The prompt for a password appears, if one is set, or the 
T-BERD ⁄ MTS 5800 user interface appears in the VNC 
viewer.

6 If the message, “Failed to connect to server” appears, the 
VNC viewer was not able to communicate with the 
T-BERD ⁄ MTS 5800. If this happens, try the following 
solutions:
– Make sure you are using the correct IP address for the 

T-BERD ⁄ MTS 5800.
– From the PC or laptop, ping the T-BERD ⁄ MTS 5800 

IP address to verify the network link is working. If the 
link is not working, restart the T-BERD ⁄ MTS 5800 and 
repeat step 2 through step 5.

7 After you have connected to the T-BERD ⁄ MTS 5800 
from a laptop or PC using the VNC viewer, use the 
computer’s mouse to control the T-BERD ⁄ MTS 5800.

8 To end a remote operation session, do one of the 
following:
– On the PC or laptop running the VNC viewer, end the 

VNC session.
– Power cycle the T-BERD ⁄ MTS 5800 (turn off then 

back on)
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Locking the test set
When using your unit remotely, it is helpful to lock the screen 
to prevent other users from disrupting your testing. When the 
test set is locked, the screen saver is displayed.

To lock the test set

1 Select the SYSTEM icon.

2 Select Test Set Lock.

3 Select Lock test set.

4 If you wish to require a password to resume using the 
instrument, select Require password and then enter the 
password.

After your remote session or test is finished, it is recom-
mended that you unlock the test set for other users.

Software upgrade
The System tools allow you to upgrade the software on the 
T-BERD ⁄ MTS 5800. For more information, see “Upgrading 
the software” on page 95.

NOTE:
The password entered here is the same password used 
with the screen saver, if enabled (a password is required to 
close the screen saver and resume using the instrument).
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Restoring factory defaults
The following procedure describes how to reset the 
T-BERD ⁄ MTS 5800 to factory default settings.

To reset to factory defaults

1 Select the SYSTEM icon.

2 Select System Info.

3 Select Reset instrument to defaults.
A confirmation menu appears.

Select OK to reset the defaults.

NOTE:
Restoring factory defaults will reset test application settings 
and system settings (such as contrast and language). It does 
NOT change or delete saved results.
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Chapter 4Basic Testing

This chapter explains basic testing concepts and procedures 
common to each test. Topics discussed in this chapter include 
the following:

– “Step 1: Selecting a test application” on page 48
– “Step 2: Configuring a test” on page 48
– “Step 3: Connecting the instrument to the circuit” on 

page 51
– “Step 4: Starting the test” on page 52
– “Step 5: Viewing test results” on page 54
– “Running multiple tests” on page 61
– “Scheduling timed tests” on page 68
– “Creating reports” on page 69
– “Creating and maintaining Custom result groups” on 

page 60
– “Restoring test defaults” on page 76
– “VT-100 emulation” on page 76
– “HTML Viewer” on page 80
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Step 1: Selecting a test application
The Test menu on the Main screen lists each of the available 
test applications. 

To select an application

1 Select Test. The Test menu appears.

2 Select the technology (for example, Ethernet), signal, 
payload, and test mode for your test application.
The instrument displays a message asking you to wait 
while it loads the application.

3 Wait for the Main screen to appear, and then proceed to 
“Step 2: Configuring a test” on page 48.

The test application is selected.

Step 2: Configuring a test
Configuring a test involves specifying test settings and option-
ally saving the test setup. 

Key settings are also available on the Main screen, on the 
Quick Config tabs. Changing key settings while running a test 
(for example, changing the pattern transmitted) triggers an 
automatic restart of the test.

Displaying the
setup page

To display the setup page

1 Using the Test menu, select a test application (see “Step 
1: Selecting a test application” on page 48).

2 Select the Setup button.
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The setup page appears and typically includes a series of 
tabs. The tabs vary based on the test application you 
selected. See Figure 20.

3 To navigate to a different setup page, select the corre-
sponding tab at the top of the screen. For example, to 
display the Traffic setup page, select the Traffic tab.

4 After you finish specifying the test settings (see “Entering 
data in the setup fields” on page 50), select the Results 
button to return to the Main screen.

Figure 20 Setup page (Ethernet settings tab for L4 testing)

TIP:
If you want to provide a screen shot of a configuration tab 
(for example, to capture the settings that you specified on 
the tab), on the Main screen, select 
Tools > Take Screenshot. A screen shot will be captured 
and stored as a PNG file in the /Disk/images folder. You 
can include the screen shot when you create reports.
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Entering data in
the setup fields

When specifying test settings, you can select a value from a 
drop-down menu, select a radio button, or tap the field to 
launch a keypad, then type a value.

To select a value from a drop-down menu
– Select the field, and then highlight the value for the 

setting.

To type text or numeric values
– Select the field to launch a keypad, type the value, and 

then select OK.
The value appears in the field.

Saving setups After you specify your test settings, you can save the setup 
(configuration) to use it again for future tests.

To save a setup (configuration)

1 On the menu bar of the Main screen, select 
Test > Save Test Config As...
The Save Test Configuration screen appears, listing 
existing saved setup files.

2 To save using the default name, go to step 6. To change 
the file name, select the filename.
The File Name dialog box appears.

3 Select the filename field.
A keyboard appears on the screen.

NOTE:
The valid ranges and values for user-specified settings 
appear at the top of the keypad. For example, if you config-
ure a constant traffic load for a 10 GigE LAN circuit, 0.001 
.. 100.000 appears at the top of the keypad, indicating 
that a number ranging from 0.001 to 100.000 is a valid 
value for the load percentage.
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4 Use the keyboard to type a name for the saved setup file. 
You do not need to enter the .tst extension; the instru-
ment automatically appends the extension to the name.

5 If you want to secure the setup so other technicians can 
not modify it (or delete it using the Delete All button), 
select Save as read-only.
If you indicate that you want to save a configuration 
(setup) as read-only, the following occurs:
– The configuration can not be deleted using the Delete 

All button.
– The configuration can be deleted using the Delete 

button.
– When you import a read-only configuration file onto 

your instrument, the instrument will retain the read-
only permissions. Any custom categories defined for 
the configuration will also be imported.

– Any custom result categories defined for the configura-
tion are also protected.

6 Select the Save button.

7 To return to the Main screen, select the Exit button.

The setup is saved and the file appears on the screen with the 
other saved setups.

Step 3: Connecting the instrument to the circuit
For detailed instructions on connecting your instrument to the 
circuit, refer to the appropriate testing manual for the circuit 
you are testing.

When connecting the unit to optical circuits, bear in mind that 
applied power must not exceed the power level specified on 
the panel for each optical connector.
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Step 4: Starting the test
After you configure a test, connect the unit to the circuit, and, 
if appropriate, turn the laser ON, the following occurs:

– If you are running a PDH, or classic SONET or SDH appli-
cation, you must turn the laser ON (if you are testing an 
optical circuit). The test starts automatically, and test 
results immediately accumulate.

– If you are running an optical terminate application, you 
must turn the laser ON, and then select Start Traffic (if 
monitoring, you do not need to start traffic).

Using the
Action buttons

After you start a test, use the buttons at the bottom of the 
screen to perform actions such as turning the laser on and off, 
starting and stopping traffic, starting and stopping a local loop-
back, and inserting errors (anomalies) or alarms (defects).

NOTE: Temperature stabilized lasers
When testing 10 Gigabit optical circuits, some lasers (par-
ticularly 1550 nm lasers) are temperature stabilized; there-
fore, they need to reach a certain temperature before you 
can use them to transmit a signal. This is expected behav-
ior, and does not indicate that there is something wrong 
with the laser or test instrument.

It typically takes up to one minute for the temperature to 
stabilize. If you have turned the laser on, but no signal is 
present on the receiving instrument or device, simply wait 
for one minute.
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Table 3 lists some common Action buttons.

Restarting a
test

To restart a test
– Select the Restart button.

The unit clears your test results, and then the test restarts.

Stopping a test

When you stop a test, test results immediately stop accumu-
lating, but remain on the display until you start the test again.

To stop a test
– Select the START/STOP button.

The test stops. To start the test again, you must press the 
START/STOP button.

Table 3 Action buttons

Button Action

Laser On/Offa Turns the laser on or off when testing optical rates.

Insert Error/Anomaly Inserts an error (anomaly) into the transmitted traffic.

Insert Alarm/Defect Inserts an alarm (defect) into the transmitted traffic.

Start Traffic/Stop Traffic Starts or stops transmission of Ethernet, IP, TCP/UDP, or 
GFP traffic over the circuit.

a. You can optionally configure optical standard Ethernet applications to automatically transmit traf-
fic after you turn the laser ON.

NOTE:
If you scheduled a timed test, the test stops automatically 
after running for the duration you specified.
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Step 5: Viewing test results
Test results appear in the Results Windows of the Main 
screen.

Setting the
result group

and category

To set the result group and category

1 Using the Test menu, select a test application see “Step 
1: Selecting a test application” on page 48), and then 
configure your test (see “Step 2: Configuring a test” on 
page 48).

2 Select the Results button to return to the Main screen.

3 Connect your instrument to the circuit. For details, refer to 
the testing manual for the circuit you are connecting to.

4 If you are testing an optical interface, select the Laser 
button.

5 If you selected an Ethernet or SONET/SDH test applica-
tion, select the Start Traffic button to start generating 
Traffic. Incoming traffic will be analyzed as soon as it is 
received.
Results appear in the Results Windows.

6 Optional. Insert errors (anomalies) or alarms (defects) into 
the traffic stream, or use the Action buttons to perform 
other actions. These buttons only appear if applicable to 
your test application.

7 Use the Group and Category buttons to specify the type 
of results you want to observe. Figure 21 illustrates 
buttons for a standard SONET application. 

Results for the category you selected appear in the result 
window.

Figure 21 Result Group and Category buttons
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For descriptions of each result, refer to the testing manual for 
the technology you are testing.

Expanding and
collapsing

result
measurements

Certain test results for which a variety of measurements are 
made (such as current, average, minimum, or peak 
throughput measurements) can now be expanded (to see all 
measurements for the test result), or collapsed (to hide 
measurements for the test result). When multiple measure-
ments exist for a result, a plus or minus sign appears to the 
right of the result name.

Collapsing the results that you are not interested in reduces 
scrolling, and allows you to observe more results that you are 
interested in simultaneously.

To expand result measurements
– Select the plus sign  to the right of the result name, or
– Select the plus sign at the bottom or the result window to 

expand all expandable results.

To collapse result measurements
– Select the minus sign  to the right of the result name, or
– Select the minus sign at the bottom or the result window 

to collapse all collapsible results.

Changing the
result layout

You can change the default layout of the test results on the 
Main screen. In many instances, it is helpful to use the Single 
layout.

TIP:
If you want to provide a screen shot of key test results, on 
the Main screen, select Tools > Take Screenshot. A screen 
shot will be captured and stored as a PNG file in the /Disk/
images folder. You can include the screen shot when you 
create reports.
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To change the default result layout

1 Select View > Result Windows.
A menu listing the available layouts appears.

2 Select a new layout.

The Result Windows appear using the layout you selected.

Using the entire
screen for

results

You can expand a single result window to use the entire 
screen by selecting the Full Screen button at the bottom of the 
pane.

To use the entire screen

1 Use the Group and Category buttons to specify the type 
of results you want to observe.

2 Select the Full Screen  button provided at the 
bottom of the results window.
The window expands to use the entire screen, and the 
result layout options provided by selecting View > Result 
Windows are disabled.

To restore the screen to its original layout, select . 
After returning the screen to its original layout, the layouts 
available from the View menu will be enabled.

Viewing
histogram

results

“Histograms” are test results that are displayed in a bar graph 
format. Histograms enable you to quickly identify spikes and 
patterns of errors or anomalies over a specific period of time 
(seconds, minutes, or hours).
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To view a histogram

1 Set one of your result groups to Summary, and then select 
the Histogram category.
The Histogram display appears.

2 You can modify the default display as follows:
– To view the complete histogram, select Single result 

window (see “Changing the result layout” on page 55).
– To scroll horizontally through the display, use the 

arrow keys at the top of the pane.
– To change the histogram interval, select the interval 

drop down (illustrated as “Sec” in Figure 22), and then 
select the new interval (Min, Hour, or Day).

Viewing an
event log

An event log is a display listing any errors, anomalies, 
alarms, or defects that occur during the course of your test. 
The log displays the value for each event, and provides the 
date and time that the event occurred.

The event log and histogram are alternative views of each 
other. They contain the same data. The event logs displays it 
all as a table, and only lists errors (anomalies) and alarms 

Figure 22 Histogram display (Single result window)
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(defects). The histogram draws a bar chart of the entire test 
and points out quiet periods vs. errored periods, or relative 
length of errored periods. 

To view an event log

1 Select the Summary group, and then select the Event Log 
category.
The associated Event Log appears.

2 To scroll through the display, use the arrow keys at the 
top of the pane.

The event log is displayed.

Viewing graphs In some applications, you can observe some results graphi-
cally, such as frame loss, packet jitter, throughput, or errors. 
Each graph provides a legend underneath the results to help 
you interpret the graph, and controls above the results that 
allow you to customize the scale and indicate whether you 
want to observe the mean, minimum, or maximum value for 
the results.

Figure 23 Event Log display (SONET application)



Chapter 4 Basic Testing
Step 5: Viewing test results

T-BERD/MTS 5800 Getting Started Manual 59

To view a graph
– Select the Graph group, and then select the category for 

the results you want to observe.
The associated Graph appears.

The graph is displayed. You can optionally save the data by 
selecting the disk icon at the top of the graph. 

Clearing
History results

To clear history results
– Select Tools > Clear History.

Historical LED results are cleared.

Figure 24 Graph display (Ethernet application)
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Creating and
maintaining

Custom result
groups

For each available test application on your unit, you can 
create Custom result groups with results from a variety of 
categories. This allows you to quickly view certain results on 
a single result window without navigating through each indi-
vidual category. You can add up to 50 results to each Custom 
group.

To create or maintain custom result groups

1 Set one of your result groups to Custom. If this is the first 
time you are creating a group, the Custom result window 
is empty.

2 Do one of the following:
– To add a new group, select New ....
– To update an existing group, select the check box to 

the left of the group name, then select the wrench 
icon.

The Configure Custom Results Category screen appears. 
The left side lists the result categories that can be added 
to your group. The right side lists the results that have 
been added.

3 Do one of the following:
– To add results, use the buttons at the top of the left 

pane to specify the group and category for the results 
you want to add, then highlight the result you want to 
add to the category.
Select the right arrow key to move the result to the 
Selected Results pane.

– To remove results, select the result you don’t want on 
the Selected Results pane, then select the left arrow 
key to move the result back to the left pane. If you 
want to delete all of the results in the category, select 
Clear.

4 Repeat step 2 and step 3 for each custom group that you 
want to add or maintain.
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5 After you finish populating the custom category with 
results (or modifying the results), press Save to store the 
category and return to the Main screen.

The Custom result group is populated. 

You can use the Delete button on the result pane (on the Main 
screen) to delete a group at any time.

Running multiple tests
You can significantly reduce your testing time by testing over 
multiple circuits simultaneously.

For example, you can transmit traffic from the DS1 and DS3 
interfaces to a network element, and then loop the traffic back 
to your unit to analyze the signals and verify that the network 
element is operating properly.

When running multiple tests, you should power your instru-
ment using the AC adapter that shipped with the instrument. 
If the instrument loses power while running multiple tests, 
when you restore power, the instrument will only restore the 
last active test application.

Restrictions Certain applications require more system resources; there-
fore, your instrument may not be able to run more than one 
application simultaneously, or you may need to consider the 
temperature before running the tests. Multiple tests can only 
be done on the 5802, 5812, 5802P or 5812P instruments.

NOTE: Protecting Custom Result Groups
When you protect a saved test configuration by making it 
read-only, the associated custom result group is also saved 
and is protected.
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Table 4 lists the applications that are limited to a single test, 
or should be run at lower temperatures.

Table 4 Multiple Test Restrictions

Application Restriction

Dual thru You can only run one Dual thru test.

IPv6 Additional tests can not be run when running an IPv6 
test.

L3 Triple Play Additional tests can not be run when running a layer 3 
Triple Play test.

DS1 Signaling Additional tests can not be run when running a DS1 Sig-
naling test.

VF test Additional tests can not be run when running a VF test.

PRI ISDN Additional tests can not be run when running a PRI 
ISDN test.

Any other application at 
a line rate less than 
10 Gbps

When running any application at a line rate less than 
10 Gbps, you can run one additional test at a line rate 
less than 10 Gbps while operating the instrument at:
– 32°F to 104°F (0°C to +40°C)

10 Gbps 
applications

When running a 10 GigE Ethernet, OC-192, or STM-64 
test, you can run one additional test (at a lower line rate) 
while operating the instrument at:
– 32°F to 95°F (0°C to +35°C)

10 Gbps Packet Capture When running a 10 GigE LAN or WAN application, and 
capturing data on Port #1, you can not run a 1 GigE 
application from Port #2. If you want to run a 1 GigE 
application on Port #2, you must first disable packet 
capture for the 10 GigE application running on Port #1.
You can run applications for lower line rates (for exam-
ple, 10/100/10000 Mbps Ethernet) on Port #2 when cap-
turing packets on Port #1 for a 10 GigE application.

Ethernet: Multiple 
Streams

Two Multiple Streams applications can not be run simul-
taneously.
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Running
multiple tests

To run multiple tests

1 Verify that your instrument is powered using the adapter 
that shipped with it.

2 Start the first test by doing the following:

a Using the Test menu, select a test application see 
“Step 1: Selecting a test application” on page 48). 

b Configure the test (see “Step 2: Configuring a test” on 
page 48).

c Connect the instrument to the circuit (refer to your 
instrument’s Getting Started Manual).

d Start the test (see “Step 4: Starting the test” on 
page 52).

3 To run a second test, do the following:

a Select Test > Add Test.
A a menu appears listing the rates still available for 
testing. These rates will vary depending on the rates 
you are already testing, and on the remaining 
resources available on your unit.
For example, if you are currently running a DS1 test on 
port 1, the DS1 rate is disabled for port 1 because the 
port is already used. 

b Select an application, and then configure the test, 
connect to the circuit, and start the test.

You are running multiple tests.

Two tabs appear on the menu bar of the Main screen (as 
shown in Figure 25), one for each test.

Figure 25 Multiple test tabs
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A tab also indicates which port the currently selected test is 
running on. The large tab indicates the currently selected test. 
Click the other tab to view the results for the second test. 

A green tab indicates no errors, anomalies, alarms, or defects 
have been detected for a test.

A red tab indicates errors, anomalies, alarms, or defects have 
been detected for a test.

A yellow tab indicates you should research the conditions 
displayed in the Summary result category. In some instances, 
the conditions constitute errors; in other instances, they are 
expected and should not be interpreted as errors. For details, 
refer to the supporting testing manual.

A blue tab indicates some action is required on your part 
before the test can proceed. Typically a dialog box will indi-
cate the type of action required.

The LEDs, results, and tabs applicable to the currently 
selected test appear on the Main screen. Each of the other 
tests is still actively running in the background.

A “Play” icon at the top right of the main window indicates that 
the currently selected test is running:

Figure 26  Test running and elapsed time



Chapter 4 Basic Testing
Running multiple tests

T-BERD/MTS 5800 Getting Started Manual 65

Viewing both
tests

When running multiple tests, you can view results for both 
tests side-by-side using the Dual Test View button.

The Dual Test View button appears when one of the following 
occurs:

– a second test is launched.
– you select Enable Dual Test from the View menu.

To view both tests
– Press the Dual Test View button.

The tests are displayed side-by-side. 

Figure 27 Dual Test View button
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If Dual Test View is launched with only one test active, the 
display will look similar to Figure 29.

Use the Add Test button to launch a second test as described 
in “Running multiple tests” on page 61.

Figure 28 Dual Test view with one active tests
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If a second test is active when viewing both tests, the display 
will look similar to Figure 29.

The buttons included in each side represent the buttons avail-
able for that test. For example, pressing the Restart on the left 
side restarts the DS3 BERT test; similarly, pressing the Show 
Actions button on the right will display the actions related to 
the 100M optical Layer 3 Traffic test, such as “Start Traffic” or 
“Insert Errors”.

If you want to simultaneously restart both tests, use the 
Restart Both Tests button in the upper right.

Use the Test menu to save the dual test configurations or to 
load a previously saved dual test configuration.

Use the Reports menu to save (create) a dual test report or 
to view a previous report.

Figure 29 Dual Test view with two active tests
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Scheduling timed tests
When you setup a test, you can indicate that the test should 
run for a specific period of time (Timed Tests), or you can 
schedule tests to begin at a specific time (Delayed-start Timed 
Test).

To schedule a timed test

1 Using the Test menu, select a test application (see “Step 
1: Selecting a test application” on page 48).

2 Select the Setup button.
A setup screen with a series of tabs appears.

3 Select the Timed Test tab, and then select one of the 
following test types:
– Timed Test. If you want the test to start immediately 

and run for a specific interval of time, select Timed 
Test, and then specify the duration for the test in the 
corresponding fields.

– Delayed-start Timed Test. If you want the test to start 
at a specific time, and then run for a specific interval of 
time, select Delayed-start Timed Test, specify the 
duration for the test, and then specify the date and 
time you want the test to begin in the corresponding 
fields.

4 Specify the timed test duration in the fields provided.

The test duration is specified. 

NOTE: J-Connect
Do not run timed tests when using J-Connect to detect 
other JDSU test instruments on a subnet. For details, see 
the Ethernet, IP, and TCP/UDP Testing Manual that 
shipped with your instrument or upgrade.
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Creating reports
Use the Reports option on the Menu bar to create or view 
reports detailing the current setup and test results. You can 
also optionally include screen shots in your reports.

Including a logo
in your reports

You can import your company logo to include it in the report.

To include a logo in your report

1 Select Reports > Import Report Logo from USB.

2 Choose a logo graphic in a .png, .jpg, or .jpeg format, 
and then put the file into the following folder on your unit:
/acterna/user/disk/bert/images

3 Select Reports > Edit User Info, and then press Select 
logo ... to navigate to the /acterna/user/disk/
bert/images folder, select the logo graphic, and then 
press Select.

The logo is selected, and you return to the Edit User Info 
screen.

Specifying
report details

Before creating a report, you can specify details that will be 
captured in the report header, such as the name, model, soft-
ware revision, serial number of the device under test, or the 
name of the technician running the test. 

To specify details about the report

1 From the menu bar, select Reports > Edit User Info.
The Edit User Info screen appears.

NOTE:
The file must be no larger than 1900 x 1200 resolution. If 
importing a file larger than this, the graphic may not appear 
on the report.
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2 To specify information about the device you are currently 
testing, select the Device Under Test tab (if it isn’t 
already displayed), and then use the keypads provided to 
type the following:
– Owner (represents the owner of the device).
– Device Under Test (represents the name or model of 

the device).
– Software Revision (represents the software revision 

the device is currently running).
– Serial Number.
– Comment.

3 If you want to specify additional comments concerning 
test results or the tester, select the Tester Comments 
tab, and use the keypads provided to type additional infor-
mation.

4 If you want to change the default name for your Handheld 
Network Test Family as provided in the report, select the 
Test Instrument tab, and then type the revised model 
name.

5 Select Ok to store the report details and return to the Main 
Screen.

Report details are specified.

Creating a
report

You can create reports in a PDF, CSV, Text, HTML, or XML 
format. Before creating a report, you can choose the type of 
content to include in the report. For example, you can include 
the details you specified as the User Info, select specific 
configuration groups (corresponding to the information that 
you specified on the setup tabs), and select key result groups 
that you want to review in detail.

You can also indicate whether you want to include captured 
screen shots in the report.
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To create a report

1 On the Main screen, select Reports > Create Report ...
The Create Report dialog box appears.

2 Your unit will automatically assign a default file name to 
your report as follows:
– The port number (if applicable) appears at the begin-

ning of the name. For example, if you are creating a 
report while running a test on Port 1, “P1_” appears at 
the beginning of the name.

– The interface appears next. For example, if you are 
currently running a test on a 1 Gigabit Ethernet circuit, 
“1GigE” appears after “P1_.

– The date and time, expressed per ISO 8601, appear 
after the interface.

– Finally, a “report” suffix ends the filename.
– The appropriate extension for the file format that you 

specify will be assigned when the report is created. 
For example, if you select the Text format, a “txt” 
extension will automatically be assigned to the file 
name.

If you do not want to use the default filename, launch the 
keypad for the File Name field, and then type a name. 

3 In Format, select PDF, CSV, Text, HTML, or XML.

4 Select Choose Contents, and then expand each of the 
following report information groups by selecting the plus 
sign to the left. 
– User Info
– Configuration Groups
– Results Groups
– Event Loggers
– Histograms
– Screenshots
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Review each of the reportable elements, and then select 
the elements you want to report, or clear those you do not 
want to include in the report output.
If you want to unselect all Report Groups or Screenshots, 
use the Unselect All or Unselect Screenshots button.
If you want to select all Report Groups or Screenshots, 
use the Select All or Select Screenshots button.

5 If you want to view the report after it is created, select the 
checkbox to the left of View report after creation.

6 Select Create Report.

A watch icon appears indicating that you should wait for the 
report to be created. If you selected View report after 
creation, the report appears automatically; otherwise, it is 
stored in the following folder and can be viewed at any time:

Disk/reports

Generating
reports

automatically

You can set up your instrument to automatically generate 
reports at specific intervals. When you set up automatic 
reports, you can also specify the file format for the reports.

To setup your instrument to generate reports automatically

1 From the menu bar, select Reports > Automatic 
Reports.
The Automatic Report Settings screen appears.

2 Select the Enable automatic reports check box.

3 Using the keypads and arrows provided, specify how 
often to create the report.

4 In Mode, specify whether you’d like the instrument to 
overwrite the previous automatic report each time it 
generates an automatic report, or create a new, separate 
report file.
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5 By default, “AutoReport” is the file name of each automat-
ically generated report, with the date and time of creation 
automatically appended to the end of the filename. If 
you’d like to use a different file name, in Report Name, 
type a new name. (The date and time will still be added.)

6 In Report Format, select a file format for the report (such 
as PDF, HTML, or others).

7 Select OK to store the settings and return to the Main 
Screen.

Reports will be automatically generated at the intervals you 
specified. When the instrument generates an automatic 
report, a dialog box will briefly appear indicating that a report 
is being generated.

Viewing a
report

To view a report

1 On the Menu bar, select Reports > View.
The Reports screen appears, listing the contents of:
acterna/user/harddisk/bert/reports

2 To display the report, select the report file from the list, 
and then select View Report.

3 You can also view a report using the file browser on the 
System page. Look in the Disk/reports directory.
The report viewer appears, providing:
– Arrows that allow you to navigate through the contents 

of the report.
– A binoculars (lookup) button that allows you to search 

for key terms in the report.
– A rotate button that rotates the display of your report, 

and changes the default report orientation from land-
scape to portrait.
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– A folder button that allows you to rename the report 
and store it in a different folder.

– An X button that closes the report viewer and returns 
you to the Reports screen.

Accessing test
reports

remotely

Using FTP, you can view, print, or save the test reports on your 
unit from a remote workstation.

To access test reports using FTP

1 Launch your web browser, and then go to the following 
address:
ftp://xxx.xxx.xxx.xxx/disk/

where xxx.xxx.xxx.xxx represents the static or DHCP 
assigned IP address.
A log on screen appears.

2 Do the following:

a In User name, enter t-berd5800 or mts5800 using 
lower case characters.

b In Password, enter acterna using lower case charac-
ters.

c Select Log On.
The bert directory (folder) appears in your browser 
window.

NOTE:
– Verify that your system’s Security Mode is set to Stan-

dard. You cannot access the test reports remotely if the 
mode is set to Enhanced.

– When using your unit remotely, it is helpful to lock the 
screen to prevent other users from disrupting your testing. 

For details on locking the screen or specifying the system’s 
security mode, refer to Chapter 3 “System Tools”. 
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3 Open the bert directory, and then open the reports 
directory.
The reports that are stored on your unit appear.

4 Select, and then save the report to a directory on your 
workstation, or simply open the report and view it 
remotely.

Exporting
reports

After generating a report, you can export the report file to a 
USB memory key. Two USB ports are provided on the right 
side of the T-BERD ⁄ MTS 5800. 

To export a report to a USB memory key

1 Insert a USB memory key into one of the ports on the right 
side of the T-BERD ⁄ MTS 5800.

2 On the Menu Bar, select Reports > Export Report.
The Reports screen appears, listing the contents of:
acterna/user/disk/bert/reports

3 Select the report you want to export, and then select the 
Export button.
The File Export dialog box appears, indicating that the 
unit is copying the selected report file to the USB memory 
key.

The report is exported.

Before removing the USB key, you must eject it.
View the File Manager (using the System icon), and then 
select the Eject USB button. After the Eject USB button disap-
pears, it is safe to remove the USB.
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Restoring test defaults
You can restore test settings to the factory defaults at any 
time.

To restore test defaults
– On the Main screen, select Tools > Reset Test to 

Defaults.

The default settings are restored for the currently running test 
(or the currently selected one if multiple tests are running).

VT-100 emulation
If your instrument is optioned to do so, you can use it to 
emulate a VT-100 terminal, and then connect it to a network 
element (such as an HTU-R, HTU-C, HRE, or SmartJack 
(NIU)) via a serial interface to gather information about the 
element. When emulating a VT-100 terminal, data from the 
network element appears on the T-BERD ⁄ MTS 5800 screen. 
You can save this information to an ASCII file, print it, or 
export it. Information gathered typically includes loss, margin, 
synchronization, performance (SES, ES, UAS, etc.), and 
alarm information.

During a VT100 session, you can also configure and provision 
the accessed network element from the T-BERD ⁄ MTS 5800. 
When using VT-100 emulation, you must connect the optional 
USB keyboard to the instrument to issue queries and 
commands.

Establishing a
serial

connection

When you order the VT-100 Emulation option, JDSU ships a 
RJ-45 cable with the instrument or option. This cable has 
been tested for use with the T-BERD ⁄ MTS 5800, and should 
be used whenever you connect the T-BERD ⁄ MTS 5800 to a 
network element for VT-100 communication. An RJ-45 to DB9 
adapter is also required. 
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To establish a serial connection for VT-100 emulation

1 Turn the T-BERD ⁄ MTS 5800 ON.

2 Verify that you have the JDSU supplied cable that 
shipped with the VT-100 option or with your test instru-
ment.

3 Connect the USB connector to one of the USB slots on 
the top panel of your test instrument.

4 Connect the DB-9 serial connector to the network 
element.

A connection is established.

Running a
VT-100 session

After establishing a serial connection to the network element, 
you can run a VT-100 terminal emulation session to query or 
configure the element.

To run a VT-100 terminal emulation session

1 If you haven’t already done so, turn the 
T-BERD ⁄ MTS 5800 ON, and establish a connection to 
the network element (see “Establishing a serial connec-
tion” on page 76).

2 From the Menu Bar, select Tools > VT-100 Emulation.
The VT-100 Terminal screen appears, with softkeys to the 
right that allow you to do the following:
– VT-100 Setup. Use this softkey to specify values for 

the session (as described in step 3 on page 78.
– Clear Screen. Use this softkey to clear the data 

currently displayed on the terminal screen.
– Hide Keyboard. Use this softkey to hide the 

keyboard. This is helpful when using a USB keyboard, 
or if you want to observe more data on the terminal 
screen.
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– Move Keyboard. Use this softkey to move the 
keyboard to the top or bottom of the terminal screen. 
This is helpful if the keyboard is blocking the display of 
key data.

– Autobaud. Use this softkey to send a series of 
sequential space characters to force the network 
element to re-evaluate its baud rate.

– Capture Screen. Use this softkey to capture the data 
on the terminal screen and save it in an ASCII file.

– Exit. Use this softkey to end the session and return to 
the Main screen.

3 To specify the settings required for the session, select 
VT-100 Setup. The VT-100 Setup screen appears. 

a Under Port Settings, specify values for the following:

Setting Value

Baud Rate Select one of the predefined baud rates 
ranging from 50 to 115200 Kbps.

Data Bits Select the number of data bits (ranging 
from 5 to 8) that contain information. 
These are the bits that are not used to 
start, stop, or provide checksum values.

Parity Indicate whether no parity check will be 
performed (None), or whether the instru-
ment will use odd or even bits for parity 
checking.

Stop Bits Indicate whether bit 1 or bit 2 will be 
used as the stop bit.

Flow Control Indicate whether the instrument will use 
software (X ON / X OFF codes), hard-
ware, or no flow control (None).
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b Under Terminal Settings, specify values for the 
following:

4 Select the Terminal Window softkey to return to the 
VT-100 Terminal screen, then use the keyboard to issue 
commands just as you would on a VT-100 terminal.

You are running a VT-100 session.

Saving terminal
screen data

When running a VT-100 session, you can capture the data on 
the terminal screen. The instrument saves the data to an 
ASCII file; you can export the file just as you would any other 
report on the instrument (see “Exporting reports” on page 75).

Setting Value

Enter/Return Select CR to send a carriage return 
every time you press Enter, LF to send a 
line feed, or CR + LF to send both.

Local Echo If you want to echo the characters you 
type on the T-BERD ⁄ MTS 5800 screen, 
select ON; otherwise, select OFF.

Enable 
Reserved 
Keys

If you want to use the keyboard’s func-
tion keys when communicating with the 
network element, select Enable; other-
wise, select Disable.
NOTE:
If you enable reserved keys, the buttons 
on your instrument will be disabled. Be 
certain to change this setting back to 
Disable when you are done with your 
VT-100 session.
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To save terminal screen data
– Select the Capture Screen softkey. The instrument 

captures the data on the terminal screen and saves it in 
an ASCII file in the following location:
/acterna/user/disk/bert/reports

The data on the screen is saved.

HTML Viewer
An HTML viewer is available on the T-BERD ⁄ MTS 5800 
which allows you to view and navigate through the HTML help 
topics and any reports that you stored in an HTML format. 
When used to display help topics, the viewer remembers and 
returns you to the last help topic you visited for a specific test 
application while you are actively running the application. You 
can return to the Contents page at any time by selecting the 
Home button. If you change test applications, the last help 
topic is no longer stored because the viewer will track the 
topics visited for the new application.

For specifics on using the viewer, see:

– “Launching the viewer” on page 80
– “Navigating using the viewer” on page 81
– “Exiting the viewer” on page 81

Launching the
viewer

The viewer is launched automatically whenever you do one of 
the following:

– Select Help > User Manual to view the topics in the 
testing manual for your instrument on the unit itself.

– Select Reports > View Report, and then select an HTML 
file.

– Select a file from the System > File Manager menu.
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Navigating
using the

viewer

The viewer provides buttons that allow you to navigate 
through a series of HTML pages.

Scrolling A scroll bar appears on the right of the viewer window; select 
and then drag it down to move to the bottom of the page, or 
drag it up to move to the top of the page.

Finding text on a
page

You can search for a specific term on a page using the Find in 
page feature.

To find a specific term

1 Select the Find in page field. A keypad appears.

2 Type the term you want to search for, and then select OK. 
The keypad closes, and the term appears in the field.

3 Select Find. The viewer scrolls to and highlights the first 
instance of the term on the page.

Selecting links Links to other help topics or HTML pages appear in blue. To 
jump to another topic or page from a link, tap the link.

Going back or
forward one pages

Buttons are provided that allow you to move Back and 
Forward through a series of previously visited pages

Going home The Home softkey takes you to the home page. For example, 
if you are browsing through the HTML help topics, pressing 
Home returns you to the Contents page.

Exiting the
viewer

To exit the viewer, use the Results or Setup button, or the 
Results of Setup hard key on the right of the front panel. You 
will return to the last Result view (on the Main screen) or the 
Setup tab that you visited before launching the HTML viewer.
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Chapter 5Optical Tools

This chapter describes the system tools on the instrument. 
Topics discussed in this chapter include the following:

– “About the optical tools” on page 84
– “Inspecting fiber” on page 84
– “Measuring optical power” on page 85
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About the optical tools
Two USB optical accessories are available for the 
T-BERD ⁄ MTS 5800. 

– Fiber Microscope
– Inspect both the bulkhead (female) and patch cord 

(male) sides of fiber interconnect as well as optical 
devices located in hard-to-reach places (transceivers).

– Inspect both simplex connectors.
– Use with a comprehensive selection of precision FBPT 

tips.
– Optical Power Meter

– Takes power measurements for all single-mode and 
multi-mode connectors via USB 2.0 connection.

– Measures optical power with multiple pre-calibrated 
wavelengths (850, 980, 1300, 1310, 1490, 1550 and 
1625 nm).

– Integrates digital power measurements, fiber inspec-
tion, and analysis into a single, unified work sequence.

Inspecting fiber
The JDSU fiber microscope accessory is used to view a live 
video of a simplex fiber to determine if the fiber is clean. It can 
also capture a snapshot and provide pass/fail analysis. 

To inspect fiber

1 Connect the fiber microscope to a USB connector on the 
right side of the instrument.
A MicroScope icon appears in the title bar.

2 Select the MicroScope icon.
The Fiber Microscope screen appears.
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3 Connect the microscope to the optical patch cord or bulk-
head.

The video of the fiber appears.

4 To view a live video feed, in the Microscope box, select 
Capture, or use Freeze to stop the live feed.

5 Use Screen Layout to select Full screen (allows a larger 
image for inspection) or Tile (allows comparison to saved 
snapshots).

6 To change the Image Brightness or Contrast, move the 
slider.

7 To save the results, do one of the following:

a Select Snapshot to save the frozen image as a .jpg.

b Select Save to save a PDF report. If desired, specify 
the job ticket details such as the company name, tech-
nician, location, and job number. If the fields are left 
blank, they will not be in included in the PDF report.

8 To compare the current results to previously saved 
results, do the following:

a Select Tile as the Screen Layout

b Select Load and then choose the result file to load.

Select the Quit button to exit the test.

Measuring optical power
The Optical Power Meter is a JDSU accessory used to 
measure optical power. 

NOTE:
Although some microscopes can inspect multi-fiber or rib-
bon fiber (depending on the microscope and the tip used) 
the T-BERD ⁄ MTS 5800’s microscope application sup-
ports simplex fiber only.
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– The MP-60 meter measures 850, 1300, 1310,1490, and 
1550 nm wavelengths

– The MP-80 meter measures 980, 1310,1480, and 
1550 nm wavelengths

To measure optical power

1 Connect the Optical Power Meter to a USB connector on 
the right side of the instrument.
The USB Power Meter Summary screen appears.

2 Connect the optical patch cord to the power meter.
The measurement appears.

3 To measure a specific wavelength, select the Wavelength.

4 Use the Display Type drop-down box to specify Power 
Meter Summary or Graph.
NOTE: The graph shows the dB result only (not available 
for dBm or mW).

5 Use the Display Units drop-down box to specify the 
measurement mode.

6 To save results, select the Save Results button.

Setting Description

dBm Absolute mode, displayed as dBm.The default 
setting.

mW Absolute mode, displayed as mW.

dB Relative measurement mode. The received 
signal is compared to the reference value, and 
displays the difference in dB.  NOTE: If no ref-
erence value has been stored, 0.00 dBm will 
be used as reference value.

SET REF Used in relative measurement mode (dB), to 
set the reference value. When selected, the 
current absolute power level is stored as new 
reference value.
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Chapter 6Maintenance and 
Troubleshooting

This chapter describes how to maintain your unit and identify 
and correct issues related to the T-BERD ⁄ MTS 5800. Topics 
discussed in this chapter include the following:

– “Cleaning the instrument and optical connections” on 
page 88

– “Maintaining the battery” on page 90
– “Calibrating the touchscreen” on page 93
– “Viewing the System Info” on page 94
– “Adding options” on page 94
– “Upgrading the software” on page 95
– “Troubleshooting” on page 97
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Cleaning the instrument and optical connections

Cleaning the
instrument

The instrument itself does not require any specialized 
cleaning. An occasional wipe with a damp cloth is sufficient.

Cleaning
optical

connections

Poor optical performance is typically due to a dirty optical 
connection, and can be resolved by cleaning the connectors 
on the optical cables and jacks. To ensure optimal optical 
performance, follow these instructions when cleaning the 
connectors.

Step 1: Gather
cleaning materials

The following materials are recommended for cleaning optical 
components:

– An optical connector cleaner, such as the CLETOP 
Cleaning Tape Cassette, manufactured by NTT-ME 
Corporation.

– An optical connector cleaning stick, such as the CLETOP 
STICK manufactured by NTT-ME Corporation, or the FI-
000S from Fiber Instruments. 

– Reagent grade isopropyl alcohol in an alcohol dispenser. 
– Lint free laboratory wipes, or pre-saturated wipes, such as 

Chemtronics CP410 wipes.
– Clean, dry, oil-free compressed air, such as FIS MICRO 

DUSTER.

NOTE:
When cleaning the instrument, JDSU recommends a damp 
cloth and water only. Cleaning with chemicals could cause 
damage to the plastic case, buttons, or removal of mark-
ings.
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Step 2: Cleaning
the cable

connectors

If optical performance of your unit is poor, clean the ferrule tip 
of the optical cable connector using alcohol and lint free lab 
wipes or a CLETOP reel type cleaner. To ensure a good 
connection, clean the connectors every time you connect the 
cables to the optical jacks.

To clean the cable connectors

1 Remove the protective cap on the optical fiber cable 
connector.

2 If you are cleaning the connector using the CLETOP reel 
type cleaner, proceed to step 3; otherwise, if you are 
cleaning the connector using alcohol wipes, do the 
following:

a If you are using a pre-saturated alcohol wipe, proceed 
to step b; otherwise, if you are using a wipe that is not 
pre-saturated, fold the wipe several times to get a pad 
of 6 to 8 layers of material, and then use the alcohol 
dispenser to dampen (without soaking) a corner of the 
pad.

b Firmly press the tip of the ferrule (see Figure 30) into 
the damp area of the wipe.

NOTE:
JDSU offers the OCK-10 Cleaning kit, which includes a 
CLETOP cleaning tape cassette, spare tape for the cas-
sette, lint free laboratory wipes, and cleaning sticks 
(swabs). To order a kit, contact JDSU Customer Care.

Figure 30 Cable connector assembly

ferrule tip
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Pinch the wipe firmly with your fingers, and then twist 
the ferrule. Repeat this process three times, using a 
clean area of the wipe each time. Clean the tip and as 
much of the outside of the ferrule as possible.

c To dry the ferrule tip, press it into a clean, dry spot of 
the wipe, pinch, and then twist one time.

d Discard the used wipe.

e Optional. Use the compressed air can to remove 
tissue fragments that may have been deposited on the 
tip of connector.

3 If you are cleaning the connector using the CLETOP reel 
type cleaner, do the following:

a Press the lever on the left of the CLETOP reel up to 
expose the cleaning tape.

b Place the top of the connector squarely at the top of 
the exposed cleaning tape.

c Rotate the connector clock-wise, and then counter 
clock-wise.

d Swipe the connector down to the bottom of the 
exposed tape.

e Release the lever on the CLETOP reel to cover and 
protect the cleaning tape.

4 Inspect the ferrule. If it is still dirty, repeat step 2 or step 3.

The cable connector is clean.

Maintaining the battery
This section discusses troubleshooting and maintenance 
information related to the T-BERD ⁄ MTS 5800’s rechargeable 
lithium-ion battery.
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Guidelines To prolong the life span of the battery, follow the guidelines 
below:

– WARNING: Danger of extreme heat, fire, or explosion if 
battery is tampered with. Use only JDSU approved Li-ION 
battery. Dispose of used batteries according to the manu-
facturer's instructions.

– Do not keep the AC adapter connected continuously. 
Disconnect the charger about once a week and operate 
the T-BERD ⁄ MTS 5800 using battery power for a period 
of time (two or three hours is recommended). If you have 
another T-BERD ⁄ MTS 5800 and battery, rotate the 
T-BERD ⁄ MTS 5800 and battery so that the battery gets 
off of the charger and gets used for some period of time 
about once a week, or as often as possible.

– When not connected to the unit, store the battery in a 
cool, dry, and clean environment. Do not leave the battery 
in a car or truck, particularly during extremely hot or cold 
weather.

– Do not place a property label on the T-BERD ⁄ MTS 5800 
under the battery. The label can interfere with the align-
ment and seating of the battery. Place labels on the side 
of the unit.

– Use the AC adapter to power up the T-BERD ⁄ MTS 5800 
the first time you use it or after prolonged storage.

– If the battery capacity is depleted or if the battery has 
been stored for a prolonged period, use the JDSU battery 
charger to charge the battery. Do not use an un-approved 
charger.

– The charger will not charge the battery when it is 
extremely hot or cold.

– Always carry a fully charged spare battery.

See “Checking the battery” on page 28 for information on 
checking the battery status.
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Recharging the
battery

The T-BERD ⁄ MTS 5800 will typically run for up to four hours 
on a fully charged battery, depending on the type of test. 
Some applications or modes require more power than others, 
so run time will vary based on the mode.

When the battery level is at 25 percent or less, the battery 
should be recharged.

To charge the battery 

1 Connect one end of the AC adapter to the power jack on 
the right side panel.

2 Connect the other end of the AC adapter to an AC power 
supply.

3 Let the T-BERD ⁄ MTS 5800 charge for up to 7 hours 
depending on the battery charge level. 
The power button is amber when the battery is charging.
The battery icon in the title bar turns green when the 
charge is above the “low battery” threshold.

Charging the battery is complete.

Replacing the
battery

The battery compartment is located on the back of the unit.

NOTE:
You can test a circuit and recharge the battery at the same 
time. If you do not want to interrupt the current test, you may 
leave the power on and connect the AC power adapter. You 
can also charge the battery while it is removed from the 
T-BERD ⁄ MTS 5800.

WARNING: ELECTRICAL SHOCK
Electrical shock may result in serious injury or death. Be 
sure the AC Adapter is connected to the correct voltage 
mains. Do not use outdoors or in wet locations. Use only 
the AC Adapter supplied with the test set.
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Before replacing the battery, verify that it is a JDSU-supplied 
replacement battery pack.

To replace the battery pack

1 Turn the power off.

2 Turn the instrument over, resting on the face.

3 Using a phillips screw driver, remove the four screws from 
the battery compartment door.

4 Remove the battery compartment door.

5 Pull the battery away from the connector on the left side.

6 Push the new battery into the connector on the left side.

7 Replace the battery compartment door.

8 Tighten the four screws until hand tight. 

Replacing the battery pack is complete.

Calibrating the touchscreen
After some time, the touchscreen may need to be calibrated. 
For example, maybe you touch the screen but the arrow 
appears elsewhere, or it doesn’t recognize the very top or 
bottom of the screen. 

CAUTION: INSTRUMENT DAMAGE
Failure to turn the power off before removing the batteries 
from the T-BERD ⁄ MTS 5800 could damage internal compo-
nents and/or corrupt the software. Always power down the unit 
before removing the battery pack.
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To calibrate the touchscreen

1 Select the SYSTEM icon.
The System screen appears.

2 Select Display.

3 Select Calibrate touchscreen.

4 Tap the screen on the cross-hairs, as prompted.

The calibration closes when finished.

Viewing the System Info
To view the revisions of internal components and to see which 
options are enabled, use the System Info menu. This menu 
also provides the serial numbers of internal components. The 
Copy System Info to File button is used to save a file that 
includes all of the system information for the instrument.

Adding options
The T-BERD ⁄ MTS 5800 software allows you to add new 
options to your unit in the field by entering a unique number 
key that will un-lock the new feature. Contact your sales repre-
sentative or call JDSU customer service to order your new 
feature and obtain the unique key for your unit. This will be a 
24-digit number. To generate this key the JDSU customer 
service representative will need the BERT serial number of 
your unit

The following procedure describes how to add options. 

To add options

1 Contact your JDSU representative to obtain the number 
key that will enable the option you want to add.
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2 Select the SYSTEM icon.

3 Select System Info.

4 Click in the New Option Key field. A keyboard appears.

5 Enter the unique number key that was provided by 
Customer Service, and then select OK.

6 Select Install to add the option.

When the menu is viewed again, a check mark appears next 
to the option indicating it is available for use.

Upgrading the software
The T-BERD ⁄ MTS 5800 software can be upgraded in the 
field using either the 10/100/1000 Ethernet port or the USB 
port on the side panel of the instrument.

The process for updating varies depending on the way the 
update is performed.

Updating over a
network

To update over a WAN

1 Select the SYSTEM icon.

2 Select Upgrade.

3 Select Network.

4 Obtain the FTP address where the software file is located, 
as well as the User Name and Password.
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5 Connect the T-BERD ⁄ MTS 5800 to the AC charger 
adapter to ensure an uninterrupted supply of power 
during the update.

6 Specify the server hostname.

7 Select Connect.
The version information is displayed.

8 Select Start Upgrade.
A dialog box appears directing you to exit any existing 
tests.

9 Select OK.

The unit reboots when done.

Updating using
USB Flash

To update over USB

1 Connect the T-BERD ⁄ MTS 5800 to the AC charger 
adapter to ensure an uninterrupted supply of power 
during the update.

WARNING: ELECTRICAL SHOCK
Electrical shock may result in serious injury or death. Be 
sure the AC adapter is connected to the correct voltage 
mains. Do not use outdoors or in wet locations. Use only 
the AC adapter supplied with the tester.

NOTE:
The update will typically take 15 to 30 minutes, depending 
on the speed of your network.

WARNING: ELECTRICAL SHOCK
Electrical shock may result in serious injury or death. Be 
sure the AC adapter is connected to the correct voltage 
mains. Do not use outdoors or in wet locations. Use only 
the AC adapter supplied with the tester.
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2 Connect a USB flash drive to the USB connector on the 
top panel.

3 Select the SYSTEM icon.

4 Select Upgrade.

5 Select USB.

6 Select Start Upgrade.
A dialog box appears directing you to exit any existing 
tests.

7 Select OK.

The unit reboots when done.

Troubleshooting
If you experience problems using your instrument, you may be 
able to solve these problems on your own after referring to this 
section. If you experience significant problems with the instru-
ment, call the Technical Assistance Center (see “Technical 
assistance” on page xx).

Setup The following issues may arise when setting up the instru-
ment.

Which transceivers
are compatible

with the
instrument?

A list of JDSU recommended optics is available by selecting 
the corresponding option from the Help menu on the user 
interface of your instrument. You can also see detailed infor-
mation for the currently inserted SFP or XFP on the Interface 
setup tab of the user interface.

NOTE:
The update will typically take 15 to 30 minutes.
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No signal is
detected when

running 10 GigE
application

There are several reasons why a signal may not be detected:

– Verify that the XFP transceiver is properly inserted.
– Turn the laser OFF, and then ON again.

Operating the
instrument

The following issues may present themselves when operating 
and performing basic functions using your instrument.

How much space
is available for my

data?

There is roughly 1 GB of space available for storing data such 
as reports.

Instrument will not
power up

There are several reasons why the instrument may not be 
powering:

– Check the power source and restart the instrument.
– If the instrument is running on the power adapter, verify 

that the power source is adequate.
– Unplug the power adapter. Remove the battery, and then 

reconnect the battery. Plug in the power adapter, and then 
turn the instrument ON.

Performing
tests

The following section addresses questions that may be asked 
about completing tests with the instrument.

Application does
not appear on the

Test menu

Ensure that the required test option is installed. For example, 
if you are looking for MiM (PBT) applications, or if you do not 
see the settings required to verify layer 2 transparency, verify 
that you installed the associated test option.
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Optical Overload
Protection is

activated

When testing on an optical circuit, the instrument displays a 
warning that the Optical Overload Protection is activated, or 
the instrument does not detect a signal.

Verify that the applied power does not exceed the power level 
supported by the connected transceiver. If it does, attenuate 
the signal.

Test results are
inconsistent

Verify the following:

– Verify that your instrument is connected to the circuit 
properly for the test you are running. For details, see 
“Connecting the T-BERD ⁄ MTS 5800 to the circuit” on 
page 36. This is the primary reason for inconsistent test 
results.

– Verify that your transceivers and cables are good and are 
connected properly for the test you are performing.

– Verify that you have inserted the correct transceiver for 
the circuit you are testing. SFPs and XFPs are designed 
to support different line rates and interfaces.

– Verify that the correct timing source is selected on the 
Interface setup screen.

– Verify that the correct line rate for the interface is 
selected.

– If you are running SONET or SDH applications, verify that 
the correct mapping, tributaries, and analysis rates are 
selected.

– If an object or person coming in contact with the test set 
causes a temporary burst of errors to be recorded, the 
errors might have been caused by an ESD event. The 
recorded errors can be cleared by pressing Test Restart. 
Please note that the test set is fully compliant with IEC 
61326-1 ESD requirements for industrial equipment and 
has passed testing according to IEC 61000-4-2 using test 
limits of 4 kV/8 kV contact/air and performance 
criterion B.
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The best method of preventing ESD events is to use an 
ESD wrist strap and/or use a grounding mat or table. 
JDSU recognizes that most field users will not have 
access to these items at will and therefore cannot have an 
ideal, ESD-free environment.
In this case JDSU offers the steps below to help reduce 
the chances of an ESD event as much as possible.

a Zero Potential - Most importantly, make sure that you 
and the test set are at Zero Potential by touching the 
metal frame of the AC mains power strip before 
touching the unit both before and during the test.

b Restricting movement – When achieving zero potential 
through the above means is not practical, it is recom-
mended to stand upright while using the test set or 
otherwise minimize movement. Even when still, use of 
ESD-safe furniture is recommended whenever 
possible.

c Clothes - Make sure not to wear any clothing that 
builds excessive electrical charge, such as a wool 
sweater.

d Weather - Electrical storms can increase the risk of 
ESD events. Unless absolutely necessary, try not to 
use the test set during an electrical storm.

e Accessories - To help reduce ESD and help prevent 
other problems, it is also a good idea to remove all 
jewelry.

Result values are
blank

Results are blank if gating criteria have not been met. Criteria 
examples include Signal Present, Frame Sync Present, 
Pointer Present, and BERT Pattern Sync Present.
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Can I do dual port
testing from a

single SFP?

Dual port testing is an option on the 5802P and 5812P instru-
ments only. On these units, two SFP jacks are provided to 
allow you to insert transceivers for different line rates or wave-
lengths without swapping SFPs. This minimizes wear and tear 
on the SFPs.

RFC 2544 test
button does not

appear

If the RFC 2544 Test button does not appear on the Main 
screen, verify the following:

– Payload analysis is ON for your current test application. 
You can not run the automated RFC 2544 when the 
instrument is configured to analyze live traffic.

– Traffic is not VPLS or MPLS encapsulated. You can not 
run the RFC 2544 tests with VPLS or MPLS encapsulated 
traffic.

– The instrument is not configured to run a multiple streams 
Ethernet test.

– The instrument is not configured to run a timed test. You 
can not run the RFC 2544 test during a timed test.

Maintaining
your instrument

The following section addresses questions that may be asked 
about maintaining your instrument.

How often does the
instrument need to

be calibrated?

The T-BERD ⁄ MTS 5800 must be calibrated every 36 
months.

What are the
recommended

insertion rates for
all components?

Each SFP or XFP transceiver can be inserted into the jacks 
provided up to 100 times. More insertions may be possible, 
but after 100 times, the pluggable optic should be checked.
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Appendix ASpecifications

This appendix contains specifications for the 
T-BERD ⁄ MTS 5800. Topics discussed in this appendix 
include the following:

– “Physical specifications” on page 104
– “Power specifications” on page 104
– “Clock source (Timing) specifications” on page 105
– “DS1 specifications” on page 106
– “E1 specifications” on page 108
– “E1 (RJ-48) specifications” on page 110
– “E3/DS3/STS-1 specifications” on page 112
– “E4/STM-1e specifications” on page 118
– “SFP specifications” on page 122
– “XFP specifications” on page 122
– “Optical specifications” on page 123
– “Environmental specifications” on page 124
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Physical specifications
The physical characteristics for the T-BERD ⁄ MTS 5800 are 
listed in Table 5.

Power specifications
Although battery life varies depending on the type of test, 
Table 6 provides specifications for the battery life and the 
specifications for the AC adapter.

Table 5 Physical specifications

Dimension 5801/5801/5812 5801P/5801P/5812P

Height 6.7 inches / 17.02 cm 6.7 inches / 17.02 cm

Width 8.4 inches / 21.34 cm 8.4 inches / 21.34 cm

Depth 2.75 inches / 7.00 cm 3.5 inches / 8.90 cm

Weight 3.25 lb / 1.47 kg 3.8 lb / 1.72 kg 

Table 6 Power specifications

Parameter Specification

Operating time Between 2 to 5 hours depending on the application

Charging time Approximately 7 hours from empty

Unit power input 12VDC, 60 Watt Max

Power supply input 100 to 240 VAC, 50/60 Hz, auto-sensing

Power supply output 12VDC, 5 AMP Max
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Supported electrical Ethernet rates
The electrical Ethernet applications use the RJ-48 jacks. 
Table 7 lists the electrical Ethernet rates supported.

Clock source (Timing) specifications
Table 8 lists internal and external timing specifications.

Table 7 Electrical rates

Rate Mbps

10Base-T Ethernet 10

100Base-T Ethernet 100

1000Base-T Ethernet 1000

Table 8 Timing specifications

Clock Source Description

Internal reference accuracy ±1.5 ppm, ±1 ppm per year aging

External BNC from BITS, SETS, or CLOCK
– BITS

1.544 Mbps DS1/T1 signal
– SETS

2.048 Mbps E1 signal
– 2MClock

2.048 MHz G.703 sync clock (square 
wave)

– 10M Clock
10.000 MHz square clock
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DS1 specifications
Table 9 on page 106 through Table 12 on page 107 list spec-
ifications for the DS1 connectors.

Receiver Table 9 lists specifications for the DS1 receivers.

Table 10 lists the input sensitivity specifications for the DS1 
receiver.

NOTE:
The E1 and DS1 interfaces should not be connected at the 
same time. Multiple connections can influence the integrity 
of the signal under test. After running your test, disconnect 
from one interface before connecting to the other interface.

Table 9 DS1 receiver specifications

Parameter Specification

Connector One RX1 Bantam Jack, and one TX/RX2 
Bantam jack; both jacks can be used as 
receivers

Bit rate 1544 kbps ±250 ppm

Line coding AMI, B8ZS

Table 10 DS1 receiver sensitivity specifications

Termination 
Type Impedance Input Range

Bridge >1000 Ω +6 to -35.0 dBdsx due to cable loss

Terminate 100 Ω nom +6 to -35.0 dBdsx due to cable loss

DSX monitor 100 Ω nom -20 dBdsx due to resistive loss in addition to 
0 to -6 dB due to cable loss
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Transmitter Table 11 lists specifications for the DS1 transmitter.

Physical
measurements

Table 12 lists frequency and level measurement specifica-
tions when running DS1 applications.

Table 11 DS1 transmitter specifications

Parameter Specification

Connector One TX/RX2 Bantam jack; only the TX/RX2 jack can be used 
as a transmitter

Output 6 Vnom peak-peak into 100 Ω
Complies with ANSI T1.403-1999.

Line build out 
(LBO) level

0 dB, -7.5 dB, -15.0 dB or -22.5 dB due to cable loss at 772 
kHz

LBO level accu-
racy

At 772 kHz relative to the signal at 0 dBdsx:
– ± 2.5 dB for -7.5 dB
– ±3 dB for -15.0 dB and -22.5 dB 

Line code AMI, B8ZS

Clock source
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from RX1
– External from BITS, SETS, or CLOCK

Frequency offset ±100 ppm, in 1 ppm steps

Pulse shape Terminated with 100 Ω resistive load and 0 dB LBO selected, 
the interface meets ITU-T Recommendation G.703 (11/01) and 
ANSI T1.102-1993

Table 12 DS1 frequency and level measurement specifications

Parameter Specification

Level V p-p Range: 8.0 V to 0.06 V
Accuracy: ± 0.04 V ± 10%
Resolution: 0.01 V
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E1 specifications
When testing E1 circuits, either BNC or RJ48 connectors can 
be used.

E1 (BNC)
specifications

Table 13 on page 109 through Table 16 on page 110 list 
specifications for the E1 (BNC) connectors.

Frequency Range: 1.544 MHz ±250 ppm
Accuracy: ± 1.5 ppm, ± 1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level dBdsx1 Range: +2.5 dBdsx to -37 dBdsx
Resolution: 0.1 dB

Level dBm2 Range: +19.0 dBm to -10.5 dBm
Resolution: 0.1 dB

1. The designation dBdsx is a level measurement in dB relative to dsx level, which is 6 V peak-
peak. A signal with a peak-peak level of 6V corresponds to 0 dBdsx.

2. Available only when unframed all ones (AIS) signal is detected.

Table 12 DS1 frequency and level measurement specifications (Continued)

Parameter Specification

NOTE:
The E1 and DS1 interfaces should not be connected at the 
same time. Multiple connections can influence the integrity 
of the signal under test. After running your test, disconnect 
from one interface before connecting to the other interface.
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Receiver (BNC) The E1 receiver operates as per ITU-G.703 (11/01). Table 13 
lists the receiver specifications.

Table 14 lists the input sensitivity specifications for the E1 
receiver.

Table 13 E1 BNC receiver specifications

Parameter Specification

Connector One unbalanced RX1 BNC, and one unbalanced TX/RX2 BNC; 
both BNCs can be used as receivers

Bit rate 2.048 Mbps

Frequency
measurement

Range: 2.048 MHz ±250 ppm 
Accuracy: ±1.5 ppm, ±1 ppm per year aging
Resolution: 1 Hz

Level
Measurement 
(Unbalanced)

Level Vp
Range: +4.0 V to 0.03 V
Accuracy: ±0.02 V ± 10%
Resolution: 0.01 V

Table 14 E1 receiver sensitivity specifications

Termination 
Type Impedance Input Range

Bridge (HI-Z) >750 Ω +4 to -35 dBnom due to cable loss

Terminate 75 Ω unbalanced +4 to -35 dBnom due to cable loss

PMP 75 Ω unbalanced -20 dBnom due to resistive loss in 
addition to 0 to -6 dB due to cable loss
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Transmitter (BNC) The E1 transmitter operates as per ITU-G.703 (11/01). 
Table 15 lists the transmitter specifications.

E1 (RJ-48)
specifications

Table 16 on page 110 through Table 18 on page 111 list spec-
ifications for the E1 (RJ-48) connector.

Receiver (RJ-48) The E1 receiver operates as per ITU-G.703 (11/01). Table 16 
lists the receiver specifications.

Table 15 E1 BNC transmitter specifications

Parameter Specification

Connector One unbalanced BNC/ 75 Ω; only the TX/RX2 BNC can be 
used as a transmitter

Line code HDB3 or AMI

Bit rate Nominal: 2.048 Mbps 
Accuracy: ±1.5 ppm, ±1 ppm per year aging
Frequency offset: ±100 ppm in 1 ppm steps

Clock Source
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from Rx1
– External from BITS, SETS, or CLOCK

Frequency offset ±100 ppm in 1 ppm steps

Pulse shape Complies with ITU-T G.703 (11/01)

Table 16 E1 RJ-48 receiver specifications

Parameter Specification

Connector Balanced RJ-48

Bit rate 2.048 Mbps

Frequency
measurement

Range: 2.048 MHz ±250 ppm 
Accuracy: ±1.5 ppm, ±1 ppm per year aging
Resolution: 1 Hz
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Table 17 lists the input sensitivity specifications for the E1 
receiver.

Transmitter (RJ-48) The E1 transmitter operates as per ITU-G.703 (11/01). 
Table 18 lists the transmitter specifications.

Level
Measurement (Balanced)

Level Vp
Range: +4 V to 0.03 V
Accuracy: ±0.02 V ± 10%
Resolution: 0.01 V

Level dBnom1:
Range: +2.5 dBnom to -37 dBnom
Resolution: 0.1 dB

1. The designation in dBnom is relative to nominal signal 3 Vp.

Table 16 E1 RJ-48 receiver specifications (Continued)

Parameter Specification

Table 17 E1 RJ-48 receiver sensitivity specifications

Termination 
Type Impedance Input Range

Bridge (HI-Z) >1200 Ω +2.5 to -35 dBnom due to cable loss

Terminate 120 Ω balanced +2.5 to -35 dBnom due to cable loss

PMP 120 Ω balanced -20 dBnom due to resistive loss in 
addition to 0 to -6 dB due to cable loss

Table 18 E1 RJ-48 transmitter specifications

Parameter Specification

Connector Balanced RJ-48

Line code HDB3 or AMI

Bit rate Nominal: 2.048 Mbps 
Accuracy: ±1.5 ppm, ±1 ppm per year aging
Frequency offset: ±100 ppm in 1 ppm steps
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E3/DS3/STS-1 specifications
Refer to these tables for specifications for the E3/DS3/STS-1 
connectors:

– Table 19 on page 112 through Table 20 on page 113 list 
specifications when running E3 applications.

– Table 22 on page 114 through Table 24 on page 116 list 
specifications when running DS3 applications.

– Table 25 on page 116 through Table 27 on page 118 list 
specifications when running STS-1 applications.

Receiver
(E3 circuits)

Table 19 lists specifications for the receiver when running 
applications for E3 circuits.

Clock Source
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from Rx1
– External from BITS, SETS, or CLOCK

Frequency offset ±100 ppm in 1 ppm steps

Pulse shape Complies with ITU-T G.703 (11/01)

Table 18 E1 RJ-48 transmitter specifications (Continued)

Parameter Specification

Table 19 E3 receiver specifications

Parameter Specification

Connector One BNC (RX1)

Bit rate 34.368 Mbps

Impedance Nominal 75 Ω at 17 MHz, unbalanced 
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Transmitter
(E3 circuits)

Table 20 lists specifications for the transmitter when running 
applications for E3 circuits.

Input Range Term: 0 to 12 dBnom due to cable loss at 17 MHz, from a 
nominal signal 
PMP: -20 dB due to resistive loss in addition to 0 to 12 dB due 
to cable loss at 17 MHz, from a nominal signal 

Table 19 E3 receiver specifications (Continued)

Parameter Specification

Table 20 E3 transmitter specifications

Parameter Specification

Connector One BNC (TX/RX2); used as transmitter only

Bit rate 34.368 Mbps

Line coding HDB3

Clock Source 
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from E3 Rx
– External from BITS, SETS, or CLOCK

Frequency offset ±100 ppm, in 1 ppm steps

Pulse Nominal 1.0 Vp Complies with ITU-T G.703 (11/01)

Impedance Nominal 75 Ω 
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Level
measurements

(E3 circuits)

Table 21 lists frequency and level measurement specifica-
tions when running applications for E3 circuits.

Receiver
(DS3 circuits)

Table 22 lists specifications for the receivers when running 
DS3 applications.

Table 21 E3 frequency and level measurement 
specifications

Parameter Specification

Tx and Rx 
Frequency 

Range: 34.368 MHz ±100 ppm
Accuracy: ±1.5 ppm, ±1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level Vp Range: 1.6 V to 0.01 V
Resolution: 0.01  V 
Accuracy: ±0.02 V ±10%

Table 22 DS3 receiver specifications

Parameter Specification

Connector One RX1 BNC, and one TX/RX2 BNC; both BNCs can be 
used as receivers

Bit rate 44.736 Mbps

Impedance Nominal 75 Ω at 22 MHz unbalanced 

Input Range High/Low: 0 to 12 dB due to cable loss at 22 MHz, from a high 
signal 
DSX/Monitor: -20 dB due to resistive loss in addition to 0 to 9 
dB due to cable loss at 22MHz, from a High signal 
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Transmitter
(DS3 circuits)

Table 23 lists specifications for the transmitter when running 
DS3 applications.

Table 23 DS3 transmitter specifications

Parameter Specification

Output One BNC (TX/RX2); can be used as transmitter or receiver.

Bit rate 44.736 Mbps

Line coding B3ZS

Clock Source
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from DS3 Rx1
– External from BITS, SETS, or CLOCK

Frequency offset ±100 ppm, in 1 ppm steps

Pulse (high) Nominal 1.15 Vp. Complies with ANSI T1.102-1993 and ITU-T 
G.703 (11/01) after passing through 450 feet of RG59B/U 
cable.

Pulse (DSX) Nominal 0.6 Vp. Complies with ANSI T1.102-1993 and ITU-T 
G.703 (11/01).

Pulse (low) Nominal 0.35 Vp

Pulse shape With output terminated in 75 Ω resistive load and DSX 
selected, the T-BERD ⁄ MTS 5800 meets ITU-T Recommen-
dation G.703 (11/01) and ANSI T1.102-1993

Impedance Nominal 75 Ω 
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Physical
measurements

(DS3 circuits)

Table 24 lists frequency, level, and jitter measurement speci-
fications when running DS3 applications.

Receiver
(STS-1 circuits)

Table 25 lists specifications for the receivers when running 
STS-1 applications.

Table 24 DS3 frequency and level measurement specifications

Parameter Specification

Tx and Rx 
frequency 

– Range: 44.736 MHz ±100 ppm
– Accuracy: ±1.5 ppm, ±1 ppm per year aging
– Resolution: 1 Hz or 1 ppm

Level Vp – Range: 1.6 V to 0.01 V
– Resolution: 0.01  V 
– Accuracy: ±0.02 V ±10%

Table 25 STS-1 receiver specifications

Parameter Specification

Connector One BNC (RX1)

Bit rate 51.84 Mbps

Impedance Nominal 75 Ω at 26 MHz unbalanced 

Range – High/Low: 0 to 12 dB due to cable loss at 26 MHz, from a 
high signal 

– DSX/Monitor: -20 dB due to resistive loss in addition to 0 
to 9 dB due to cable loss at 26 MHz, from a High signal 
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Transmitter
(STS-1 circuits)

Table 26 lists specifications for the transmitter when running 
STS-1 applications.

Table 26 STS-1 transmitter specifications

Parameter Specification

Connector One BNC (TX/RX2); used as transmitter only

Bit rate 51.84 Mbps

Line coding B3ZS

Clock Source
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from STS-1 Rx1
– External from BITS, SETS, or CLOCK

Frequency offset ±50 ppm, in 1 ppm steps

Pulse (high) Nominal 1.15 Vp. Complies with ANSI T1.102-1993 and ITU-T 
G.703 (11/01) after passing through 450 feet of RG59B/U 
cable.

Pulse (DSX) Nominal 0.6 Vp. Complies with ANSI T1.102-1993 and ITU-T 
G.703 (11/01).

Pulse (low) Nominal 0.32 Vp

Pulse shape With output terminated in 75 Ω resistive load and DSX 
selected, the Handheld Network Test Family meets ITU-T 
Recommendation G.703 (11/01) and ANSI T1.102-1993

Impedance Nominal 75 Ω



Appendix A Specifications
E4/STM-1e specifications

118 T-BERD/MTS 5800 Getting Started Manual

Physical
measurements
(STS-1 circuits)

Table 27 lists frequency and level measurement specifica-
tions when running STS-1 applications.

E4/STM-1e specifications
Refer to these tables for specifications for the E4/STM-1e 
connector:

– Table 28 on page 119 through Table 30 on page 120 list 
specifications for E4 receivers, transmitters, and 
frequency and level measurements.

– Table 31 on page 120 through Table 33 on page 121 list 
specifications for STM-1 receivers, transmitters, and 
frequency and level measurements.

Table 27 STS-1 frequency and level measurement specifications

Parameter Specification

Tx and Rx 
frequency 

Range: 51.84 MHz ±50 ppm
Accuracy: ±1.5 ppm, ±1 ppm per year aging
Resolution: 1 Hz or 1 ppm

Level Vp Range: 1.6 V to 0.01 V
Resolution: 0.01  V 
Accuracy: ±0.02 V ±10%
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Receiver
(E4 circuits)

Table 28 lists specifications for the receiver when running E4 
applications.

Transmitter
(E4 circuits)

Table 29 lists specifications for the transmitter when running 
E4 applications.

Table 28 E4 receiver specifications

Parameter Specification

Connector One BNC

Bit rate 139.264 Mbps

Impedance Nominal 75 Ω at 70 MHz unbalanced 

Range – Term: 0 to 12 dB due to cable loss at 70 MHz, from a 
nominal signal 

– Monitor: -20 dB due to resistive loss in addition to 0 to 12 
dB due to cable loss at 70 MHz, from a nominal signal 

Table 29 E4 transmitter specifications

Parameter Specification

Connector One BNC

Bit rate 139.264 Mbps

Line coding CMI

Tx clock
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from E4 Rx
– External from BITS, SETS, or CLOCK

Frequency offset ±50 ppm, in 1 ppm steps

Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)

Impedance Nominal 75 Ω 



Appendix A Specifications
E4/STM-1e specifications

120 T-BERD/MTS 5800 Getting Started Manual

Physical
measurements

(E4 circuits)

Table 30 lists frequency and level measurement specifica-
tions when running E4 applications.

Receiver
(STM-1e
circuits)

Table 31 lists specifications for the receiver when running 
STM-1e applications.

Table 30 E4 frequency and level measurement specifications

Parameter Specification

Tx and Rx 
Frequency 

– Range: 139.264 MHz ±100 ppm
– Accuracy: ±1.5 ppm, ±1 ppm per year aging
– Resolution: 1 Hz, or 1 ppm

Level Vpp – Range: 1.4 V to 0.01 V
– Resolution: 0.01  V 
– Accuracy: ±0.02 V ±10%

Table 31 STM-1e receiver specifications

Parameter Specification

Connector One BNC

Bit rate 155.52 Mbps

Impedance Nominal 75 Ω at 78 MHz unbalanced 

Range Term: 0 to 12.7 dB due to cable loss at 78 MHz, from a 
nominal signal 
PMP: -20 dB due to resistive loss in addition to 0 to 12.7 dB 
due to cable loss at 70 MHz, from a nominal signal 
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Transmitter
(STM-1e
circuits)

Table 32 lists specifications for the transmitter when running 
STM-1e applications.

Physical
measurements

(STM-1e
circuits)

Table 33 lists frequency and level measurement specifica-
tions when running STM-1e applications.

Table 32 STM-1e transmitter specifications

Parameter Specification

Connector One BNC

Bit rate 155.52 Mbps

Line coding CMI

Tx clock
(Timing)

– Internal reference clock with accuracy ±1.5 ppm, ±1 ppm 
per year aging

– Recovered from Rx1
– External from BITS, SETS, or CLOCK

Frequency offset ±50 ppm, in 1 ppm steps

Pulse Nominal 1.0 Vpp Complies with ITU-T G.703 (11/01)

Impedance Nominal 75 Ω 

Table 33 STM-1e frequency and level measurement specifications

Parameter Specification

Tx and Rx 
Frequency 

– Range: 155.52 MHz ±50 ppm
– Accuracy: ±1.5 ppm, ±1 ppm per year aging
– Resolution: 1 Hz or 1 ppm

Level Vpp – Range: 1.4 V to 0.01 V
– Resolution: 0.01  V 
– Accuracy: ±0.02 V ±10%
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SFP specifications
The interfaces of the SFP comply with INF-8074i, Rev 1.0 
published on May 12, 2001. Performance is only guaranteed 
when using JDSU Recommended Optics.

Supported
optical rates

Table 34 provides the optical SONET, SDH, and Ethernet 
rates supported by the SFP.

XFP specifications
The interface of the XFP complies with INF-8077i, Rev 4.5 
published on August 31, 2005. Performance is only guaran-
teed when using JDSU Recommended Optics.

The XFP supports the 10 Gigabit optical interfaces listed in 
Table 35.

Table 34 SONET, SDH, and Ethernet rates

Rate SONET SDH Ethernet

4 Gbps N/A N/A N/A

2.5 Gbps OC-48 STM-16 N/A

2 Gbps N/A N/A N/A

1 Gbps N/A N/A 1 GigE

622 Mbps OC-12 STM-4 N/A

155 Mbps OC-3 STM-1 N/A

100 Mbps N/A N/A 100M

Table 35 SONET, SDH, and Ethernet rates

Rate SONET SDH Ethernet

10 Gbps OC-192 STM-64 10GigE
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Optical specifications
Table 36 lists specifications when testing optical circuits.

Transceiver specifications
For detailed transceiver specifications, refer to your SFP or 
XFP manufacturer’s web site. Summarized information for 
inserted transceivers (such as the model number, supported 
wavelength, and supported interface) is provided on the user 
interface (GUI).

If you are not certain whether you are using a JDSU recom-
mended transceiver, contact your local JDSU representative, 
or review the list of JDSU Recommended Optics that shipped 
with the transceiver.

Table 36 Optical specifications

Item Description

Clock frequency accuracy ±1.5 ppm ±1 ppm per year aging

Transmitter frequency offset ±50 ppm from the nominal rate, in 1 ppm steps

Frequency measurement accuracy ±1.5 ppm ±1 ppm per year aging

APS1

 resolution
 accuracy

1ms
1ms

RTD
 resolution
 accuracy

1 μs
2 μs

1. Published resolution and accuracy only ensured when using JDSU recommended transceivers 
(optics).
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Environmental specifications
Table 37 lists the environmental characteristics for the 
T-BERD ⁄ MTS 5800. Operating temperature and humidity 
are provided below; for storage temperature and humidity, see 
“Storing the instrument” on page 126.

Table 37 Environmental specifications

Item Description

Operating Temperature 32° F to 122° F (0° C to +50° C)
Note: For maximum battery capacity and runtime, limit 
charge and discharge temperature of the battery to 40°C 
(104° F).

Operating Humidity 0% to 90% relative humidity, non-condensing

Shock/Drop/Vibe Shock - per IEC 68-2-27 and 68-2-29 Ed. 2.0

Drop - per IEC 721-3-7 2nd Ed. /IEC 61010-1
Vibration - per IEC 68-2-6 and MIL-PRF-28800F (Class 2)
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Appendix BStorage and Shipment

This appendix describes how to store and ship your test 
instrument. Topics discussed in this appendix include the 
following:

– “Storing the instrument” on page 126
– “Shipping the your instrument” on page 127
– “Returning equipment to JDSU” on page 127
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Storing the instrument
When the instrument is not in use, it can be stored. You should 
follow the criteria below when storing the Handheld Network 
Test Family.

Environmental
specifications

The T-BERD ⁄ MTS 5800 should be stored according to the 
environmental specifications listed in Table 38. 

Other
environmental

limitations

The battery discharges slowly while in the instrument. 
Continued storage while in a discharged state could result in 
performance degradation. For this reason, JDSU recom-
mends removing the battery if the instrument will not be used 
for more than a week. Store the battery in a cool, dry, clean 
environment. Do not leave the battery in a car or truck, partic-
ularly during extremely warm weather. 

While out of the instrument, the battery will discharge at a slow 
rate. JDSU recommends checking the battery periodically 
while it is in storage, and keeping it charged to at least 40%. 
For additional information about maintaining the battery, see 
“Maintaining the battery” on page 90.

The first time you use the instrument after prolonged storage, 
use the AC adapter to power up the unit.

Table 38 Environmental specifications for storage

Item Description

Storage Temperature -4° F to 140° F (-20° C to +60° C)

Humidity at 86° F (30° C) 0% to 95% relative humidity, 
non-condensing
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Shipping the your instrument
If you will be shipping the instrument, you should follow the 
guidelines below.

When packing the instrument for shipment, JDSU recom-
mends using the original shipping container and packing 
materials. If the original container and packing materials are 
damaged or not available, the components should be care-
fully packed so that they will not be damaged in transit. JDSU 
recommends using anti-static packing material to secure the 
components inside a box or other container. If needed, you 
can obtain appropriate packing materials by contacting JDSU 
Customer Care at 1-866-228-3762 or at www.jdsu.com. 

Returning equipment to JDSU
Before you return any equipment to JDSU, contact JDSU 
Customer Care at 1-866-228-3762 or at www.jdsu.com for the 
correct shipping address and for a Return or Reference 
Authorization. You must have a Return or Reference Authori-
zation whenever you return equipment to JDSU. 

For each piece of equipment returned for repair, attach a tag 
that includes the following information:

– Owner’s name, address, and telephone number.
– The serial number, product type, and model.
– Warranty status. (If you are unsure of the warranty status 

of your instrument, contact JDSU Customer Care.)
– A detailed description of the problem or service 

requested.

NOTE:
JDSU is not liable for any damage that may occur during shipping.

http://www.jdsu.com
http://www.jdsu.com
www.acterna.com
www.acterna.com
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– The name and telephone number of the person to contact 
regarding questions about the repair.

– The return authorization (RA) number (US customers), or 
reference number (European Customers).

Clearly mark the outside of the package with the JDSU-issued 
Return or Reference Authorization number and ship it prepaid 
and insured to JDSU. For information on packaging equip-
ment for shipment, see “Shipping the your instrument” on 
page 127. 
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Appendix CCustomer Services 

This appendix describes the customer services available 
through JDSU. Topics discussed in this appendix include the 
following:

– “About our services” on page 130
– “Standard support services” on page 130
– “Add-on services” on page 132
– “Training options” on page 133
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About our services
JDSU offers an unmatched and comprehensive portfolio of 
standard support services, add-on services, and training 
options to help customers successfully use purchased JDSU 
products. Services that come standard with every product 
sale include business hour technical assistance, in-warranty 
repair, calibration services, upgrade services, and immediate 
return authorizations. Add-on services designed to optimize 
product capabilities and maximize efficiencies include field 
engineering and deployment, technical training, 24x7 product 
support, consulting, and custom software development. Refer 
to the sections that follow for additional details.

Standard support services
Standard support services that accompany the sale of every 
JDSU product include:

– Instrument repair and calibration services
– Business hour technical assistance
– Access to general warranty information on the JDSU Web 

site
– Extensive product documentation and related technical 

information, accessible on the JDSU Web site

Instrument
repair and
calibration

services

Our service centers provide repair and calibration services for 
JDSU equipment. JDSU understands the impact of equip-
ment down time on operations and is staffed to ensure a quick 
turnaround. Available services include the following:

Product Repair — All equipment returned for service is 
tested to the same rigorous standards as newly manufactured 
equipment. This ensures products meet all published specifi-
cations, including any applicable product updates.
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Calibration — JDSU’s calibration methods are ISO approved 
and based on national standards.

For more information, including instructions for returning 
equipment for repair and/or calibration, go to: www.jdsu.com/
en-us/Test-and-Measurement/support/repair-and-calibration/
Pages/default.aspx.

Technical
assistance

(business hour)

Expert business hour technical support is provided with your 
product. For assistance related to the use of your product, call 
or e-mail JDSU’s Technical Assistance Center (TAC) in your 
region. For a current listing of TAC phone numbers and e-mail 
addresses, go to: www.jdsu.com/en-us/Test-and-Measure-
ment/support/technical-assistance/Pages/default.aspx.

For information about optional 24x7 technical assistance, see 
“Extended product and systems support services” on 
page 132.

Warranty
information

Information about standard warranties, terms, and conditions 
specific to JDSU’s Test & Measurement products and third 
party software that may be included within such products is 
posted on the JDSU Web site. For more information, go to: 
www.jdsu.com/terms.

Product
documentation

library

An extensive library that includes documentation for JDSU 
products and related technology-specific documents is avail-
able on the JDSU Web site. For more information, go to: 
www.jdsu.com/en-us/Test-and-Measurement/support/Tech-
nical-Library/Pages/TechLibrary.aspx.

http://www.jdsu.com/en-us/Test-and-Measurement/support/repair-and-calibration/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/support/repair-and-calibration/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/support/repair-and-calibration/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/support/technical-assistance/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/support/technical-assistance/Pages/default.aspx
http://www.jdsu.com/terms
http://www.jdsu.com/en-us/Test-and-Measurement/support/Technical-Library/Pages/TechLibrary.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/support/Technical-Library/Pages/TechLibrary.aspx
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Add-on services
JDSU offers a broad portfolio of add-on services to enable 
customers to aggressively build their competitive advantage 
within the markets they serve. Available services include:

– Extended product and systems support, including:
– Optional extended product warranties
– Optional extended repair services
– Calibration management services
– Around-the-clock technical assistance
– A certified pre-owned equipment program
– Tailored support services for your JDSU system

– Various professional and consulting services
– Specialized managed services

Extended
product and

systems
support

services

For information about optional extended product warranties, 
go to: www.jdsu.com/en-us/Test-and-Measurement/services/
a-z-service-list/Pages/ext-warr.aspx.

For information about optional extended equipment repair 
services, go to: www.jdsu.com/en-us/Test-and-Measurement/
services/a-z-service-list/Pages/factory-repair.aspx.

For information about equipment calibration management 
services, go to: www.jdsu.com/en-us/Test-and-Measurement/
services/a-z-service-list/Pages/calibration.aspx.

For information about optional 24x7 technical assistance, go 
to: www.jdsu.com/en-us/Test-and-Measurement/services/a-
z-service-list/Pages/tac.aspx.

For information about JDSU’s Assets and Certified Equipment 
(ACE) Program (for the resale of certified pre-owned equip-
ment), go to: www.jdsu.com/en-us/Test-and-Measurement/
services/a-z-service-list/Pages/ace-prgm.aspx.

http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/ext-warr.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/ext-warr.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/factory-repair.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/factory-repair.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/calibration.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/calibration.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/tac.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/tac.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/ace-prgm.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/a-z-service-list/Pages/ace-prgm.aspx
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For information about tailored support services for your JDSU 
system, go to: www.jdsu.com/en-us/Test-and-Measurement/
services/products-and-systems-support/systems-support/
Pages/default.aspx.

Professional
and consulting

services

For information about optional professional and consulting 
services available from JDSU, go to: www.jdsu.com/en-us/
Test-and-Measurement/services/professional-and-
consulting-services/Pages/default.aspx.

Managed
services

For information about specialized managed services available 
from JDSU, go to: www.jdsu.com/en-us/Test-and-Measure-
ment/services/managed-services/Pages/default.aspx.

Training options
JDSU offers a wide array of training options designed to 
support customers at various stages of the network life cycle. 
Training options include:

– Public training
– On-site training
– Virtual classroom
– Self-paced training
– Certifications
– Workshops and blended learning
– Train-the-trainer/course licensing
– Free Webinars
– Contact training

For more information about available training options, go to: 
www.jdsu.com/en-us/Test-and-Measurement/Training/
Pages/default.aspx.

http://www.jdsu.com/en-us/Test-and-Measurement/services/products-and-systems-support/systems-support/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/products-and-systems-support/systems-support/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/products-and-systems-support/systems-support/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/professional-and-consulting-services/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/professional-and-consulting-services/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/professional-and-consulting-services/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/managed-services/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/services/managed-services/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/Training/Pages/default.aspx
http://www.jdsu.com/en-us/Test-and-Measurement/Training/Pages/default.aspx
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Glossary

Symbols/Numerics

10G — Used on the connector 
panel to represent 
10 Gigabit Ethernet.

10GE — Used on the connector 
panel to represent 
10 Gigabit Ethernet.

10GigE — Used throughout this 
manual to represent 
10 Gigabit Ethernet.

802.11b — IEEE standard for 
wireless LANs. You can estab-
lish wireless LAN connections to 
the T-BERD ⁄ MTS 5800 using 
an 802.11 adapter.

A

AC — Alternating Current. An 
AC power adapter is supplied 
with the T-BERD ⁄ MTS 5800.

B

BER — Bit Error Rate.

BERT — Bit error rate test. A 
known pattern of bits is trans-
mitted, and errors received are 
counted to figure the BER. The 
Bit Error Rate test is used to 
measure transmission quality.

D

DHCP — Dynamic Host Config-
uration Protocol. A communica-
tions protocol that assigns IP 
addresses dynamically as 
needed. The test instrument 
supports static IP address 
assignment.
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E

Ethernet — A LAN protocol. 
Using the T-BERD ⁄ MTS 5800, 
you can test and verify Ethernet 
network elements and services.

Ethernet link partner — The 
nearest Ethernet device on a 
link. The T-BERD ⁄ MTS 5800 
auto-negotiates its capabilities 
with this device when you 
initialize a link.

F

FTP — File transfer protocol. 
Protocol used on LANs and the 
Internet to transfer files.

G

GigE — Used throughout this 
manual to represent Gigabit 
Ethernet.

GUI — Graphical User Inter-
face. Layout of commands in a 
user-friendly environment. See 
also UI (user interface).

H

Histogram — Print output of 
specific results in a bar graph 
format.

I

ISO — International Organiza-
tion for Standardization.

IP — Internet Protocol. Protocol 
specifying the format and 
address scheme of packets 
transmitted over the Internet. 
Typically used with TCP.

L

LAN — Local Access Network.

LED — Light emitting diode.

LLB — Line loopback.

LiION — Lithium Ion. The 
T-BERD ⁄ MTS 5800 can be 
equipped with a rechargeable 
Lithium Ion battery.

M

MDI — Medium dependent 
interface.

MDI-X — Medium dependent 
interface crossover.

Msg — Message.

O

OC-3 — Optical carrier 3. A 
SONET channel equal to three 
DS3s (155.52 Mbps).
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OC-12 — Optical carrier 12. A 
SONET channel of 622.08 
Mbps.

OC-48 — Optical Carrier 48. 
SONET channel of 2.488 Gbps. 

OC-192 — Optical Carrier 192. 
SONET channel of 9.953 Gbps.

P

Packet — Bundle of data, 
configured for transmission. 
Consists of data to be trans-
mitted and control information.

R

RJ 48-45 — Jack used for 10/
100/1000 Mbps Ethernet 
testing.

Rx — Receive or receiver or 
input.

S

SDH — Synchronous Data 
Hierarchy.

SONET — Synchronous optical 
network.

STM-1e — An electrical SDH 
signal of 155.52 Mbps.

STM-4 — An SDH signal of 
622.08 Mbps.

STM-16 — An SDH signal of 
2488.32 Mbps.

STM-64 — An SDH signal of 
9.953 Gbps.

STS-1 — An electrical SONET 
signal of 51.84 Mbps.

Sync — Synchronization.

T

Term — See Terminate

Terminate — An application 
where the test set is terminating 
the circuit. In these applications, 
the test set sends and receives 
traffic.

Through — An application 
where the test set is used in 
series with a network circuit to 
monitor the traffic on that circuit.

Tx — Transmit or transmitter or 
output.

U

USB — Universal Serial Bus. A 
bus designed to handle a broad 
range of devices, such as 
keyboards, mouses, printers, 
modems, and hubs.
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V

VNC — Virtual Network 
Computing. A thin client system 
that enables you to run applica-
tions on a VNC server from any 
other computer connected to the 
Internet. Using VNC, you can 
run the T-BERD ⁄ MTS 5800 
from a remote workstation, and 
you can run remote applications 
from the T-BERD ⁄ MTS 5800.

W

WAN — Wide area network.

X

XFP — 10 Gigabit Small Form 
Factor Pluggable optical trans-
ceiver. A variety of optional 
XFPs are available for testing 10 
Gigabit LAN or 10 Gigabit WAN 
fibre circuits.
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